
In Situ FIRe

Operation Manual 1.1.4

SAT-DN-00590-1.1.4-273

2014/03/25 01:13

Copyright © 2012, Satlantic. All rights reserved.





Table of Contents
Quick Start 5

Overview 7

About In Situ FIRe 8
Principle of Operation 10
Major Components 17
Instrument Drawings 19
External Interfaces 22
Ancillary Sensors 26
Accessories 27
Specifications 30

Software 32

FIReCom Overview 33
Installing FIReCom 34
Uninstalling FIReCom 39
Navigating FIReCom 47
FIReCom Dashboard 52
Connecting to FIRe 54
FIReCom Preferences 57
Message Logging 59

Settings 61

FIRe Settings 62
Flash Sequence Settings 64
Flash Timing Explained 66
Flash Iteration Settings 68
Gain Settings 69
On Board Processing 71
Clock Synchronization 72
Sensor Summary Report 73

Deployment 74

Deployment Procedures 75
Creating Blank Profiles 79
Pressure Sensor Calibration 81
Real Time Data Acquisition 82
Real Time Data Display 84
Logging Real Time Data 89
Monitoring Real Time Data Acquisition 91
PAR Sensor Calibration 93
Application Files 94

Data Recovery and Processing 95

Transferring Files 96
Data Processing 97



Processing Raw Data 100
Post-Processing Options 102
Advanced Processing Settings 104
Replay Processed Data 106

Troubleshooting 107

Maintenance 111

Safety and Hazards 112

Warranty 114

Contact Satlantic 115

Data Formats Reference 116

Command Reference 124

Index 132



Quick Start
1. Run the program FIReCom-<version>-b<build>-x86.exe (e.g. FIReCom-1.1.0-b01-x86.exe) to

install FIReCom on your personal computer. See Installing FIReCom for details on installation
requirements. If FIReCom and the 1.1.1 In Situ FIRe USB driver have already installed on your
computer, proceed to step 2.

2. If the computer being used has not been connected to In Situ FIRe before, it needs to complete
installation of the In Situ FIRe USB driver for the instrument. Ensure that FIReCom is not running.
Connect the power/USB/RS232 cable between the instrument's 8 pin male bulkhead connector and
a USB port on the PC (the instrument does not have to be powered). The operating system will first
complete installation of the native USB driver and then the VCP (virtual COM port) USB driver.

3. Select Start->Programs->FIReCom->FIReCom to run FIReCom.

4. Before connecting power to In Situ FIRe, ensure it has been powered off for at least 20 seconds to
allow the internal backup power to discharge. Rapidly cycling power can prevent successful restart.

5. Apply power to In Situ FIRe. This can be done using the 8 pin bulkhead connector and the
power/USB/RS232 cable using a power supply (8-18 VDC) or battery (12 V). If using a power
supply, it should be able to source at least 2 Amps. The in situ FIRe can also be powered from the
6pin bulkhead connector, using 18-72 VDC. See Accessories for more details.

6. When In Situ FIRe has completed start-up and initialization (60 seconds after connecting power
source), FIReCom will automatically enter Setup mode and enable applicable buttons on the
dashboard.

7. Select Sensor->Operation Mode to open the Operation Mode dialog. If this dialog fails to open or
reports an error, then there is a problem with the connection. See Troubleshooting for help.

8. Review the FIRe Settings and modify if desired. Press F1 key for help on any selected setting.

9. Select Cancel to continue with default settings or select OK to apply changes.

10. Fill the flow cell with a water sample, or submerge In Situ FIRe in a container of water.

11. Select the Sample button on the FIReCom dashboard to start acquiring sensor data in real time.
FIReCom will display graphic plots of sensor data as they are received in real time from In Situ FIRe
. Note that if no active fluorescence signal is detected, FIReCom will report errors because it is not
able to properly calculate fitting parameters.

To switch from USB to serial communications, do the following:

1. Click the FIRe Settings button and note the Serial Port settings. The default is RS-232 at 38400
baud.
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2. Disconnect the USB cable from the PC. Failure to disconnect the USB cable can prevent a
successful serial connection to In Situ FIRe.

3. Ensure that your computer has an active Internet connection to allow the operating system to search
for drivers.

4. Connect the RS232 cable directly to a 9 pin serial connector on your computer, or via the serial-USB
converter supplied with In Situ FIRe. Note that other serial-USB converters may cause problems.

5. Select Sensor -> Connect Serial from the main menu.

6. Select the baud rate noted in step 1 above.

7. Select the COM port to which In Situ FIRe is phisically or virtually connected.

8. Press Connect to establish communication with In Situ FIRe.

CAUTION: In Situ FIRe is a complex instrument with numerous configuration options and settings. Before
configuring and operating your In Situ FIRe, please ensure you understand the following basic operating
principles:

• In Situ FIRe can be configured to collect any combination of STF (single turnover flash) and MTF
(multiple turnover flash) profiles by creating sequences in FIReCom and uploading them to In Situ
FIRe. Multiple sequences can be defined, but only the Active sequence will be executed. Ensure
that the right sequence is active. See Principle of Operation and Flash Sequence Settings for more
information.

• In Situ FIRe can be configured to collect (and output) Raw or Processed STF data products on
board. See FIRe Settings for instructions.

• Raw data files logged internally by In Situ FIRe, or externally by FIReCom, can be post-processed
as described in Processing Raw Data . MTF processed data is never processed on board In Situ
FIRe, it must be done in post processing. Simple file playback for visual display is available by post
processing with Post-Processing Options disabled.
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Overview
This chapter provides an overview of In Situ FIRe, how the sensor works, and physical and electrical
specifications.

Topics in this chapter include:

• About In Situ FIRe

• Principle of Operation

• Major Components

• Instrument Drawings

• External Interfaces

• Ancillary Sensors

• Accessories

• Specifications
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About In Situ FIRe

In Situ FIRe ( F luorescence I nduction and Re laxation) is a cost-effective solution for real-time
chlorophyll analysis in coastal and freshwater environments, providing quick and continuous
measurements.

Satlantic In Situ FIRe

Based on the research of Dr. Maxim Gorbunov and Dr. Paul Falkowski from Rutgers University, the FIRe
technique uses active stimulation and highly resolved detection of the induction and subsequent
relaxation of chlorophyll fluorescence yields on micro- and milli-second time scales.

Some of the many technical highlights of In Situ FIRe include:

• Exceptional sensitivity for measurements in low chlorophyll open ocean conditions.

• Real-time measurements of the excitation flash intensity to quantify absolute functional absorption
cross-sections ( PSII ).

• Measurement of the reference excitation profile to provide real-time corrected fluorescence yields.

• A highly uniform LED light source that excites Chl a at 450 nm (680 nm detection).

• High ambient light rejection characteristics of the detector optics.

• Real-time processing of single turnover induction parameters (Fv/Fm, PSII ).

• A standard integrated depth sensor and optional ambient PAR sensor.

• A flow cell accessory for dark-adapted measurements and pumped configurations.

• RS-232, RS-422, USB, and analog telemetry.

In Situ FIRe comes complete with FIReCom, a full-featured graphical application for Windows
XP/Vista/7/8 and Mac OS X that provides easy access to all operational features of FIRe:

• configure sensor settings

• control sensor sampling
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• visualize data in real time

• retrieve and process collected data
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Principle of Operation

In Situ FIRe characterizes the photosynthetic physiology of oceanic and freshwater microalgae and
bacteria. Measurements are made by illuminating the sample with an intense flash of light (approx.
50,000 µmol photons ), sufficient to instantaneously saturate the photosystem II (PSII) reaction
centers at the primary electron acceptor, , (STF), or the plastoquinone pool, PQ, (MTF).

Either excitation type is then followed by a relaxation (order of some 100 ms), which allows the reduced
reaction centers to reoxidize. The rate of reoxidation is measured via brief (1 µs) intermittent light flashes,
and the fluorescence response to these flashes. These intermittent flashes are sufficiently weak in
intensity and length to not induce a fluorescence induction, or actinic, effect.

The excitation phase is also called induction phase or flash phase, and abbreviations used in the
literature are STI (Single Turnover Induction), STF (Single Turnover Flash), MTI (Multiple Turnover
Induction), or MTF (Multiple Turnover Flash). The relaxation phase following the excitation is similarly
abbreviated as STR (Single Turnover Relaxation) or STRP (Single Turnover Relaxation Phase). The
corresponding terms for Multiple Turnover are MTR or MTRP. The complete excitation plus relaxation
sequence is called a Single Turnover (ST) or Multiple Turnover (MT) profile.
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Physiological Models

The fluorescence profiles as measured by the In-Situ FIRe are interpreted according to the model
described by:

Z. S. Kolber, O.Prasil, and P. G. Falkowski, Measurements of variable chlorophyll fluorescence using fast
repetition rate techniques: defining methodology and experimental protocols , Biochimica et Biophysica
Acta 1367 (1998) 88-106.

The profile analysis provides a quantitative characterization of the investigated sample via the functional
cross section, the quantum yield, and other values (see below).

Terms and abbreviations

PS II
Photosystem II

RC II
Reaction Centers of PS II

Electron acceptor quinone, the primary electron acceptor of PS II . is the target saturation for
STF protocols.

Electron acceptor quinone, the secondary electron acceptor of PS II
PQ

Plastoquinone, a subunit protein of PS II, another electron acceptor. The plastoquinone pool is the
target or saturation for MTF protocols.

ST
Single Turnover, a fluorescence induction protocol that ensures the reduction of all PSII RC’s
instantaneously. This protocol is achieved through a single, 80 – 120 µs flash of light with an
intensity of approximately 8,000 µmol photons .

MT
Multiple Turnover, a fluorescence induction protocol that ensures sequential reduction of PS II at
QA, QB, and PQ. This protocol is achieved through a frequency modulated flash lasting 500 – 800
ms at an integrated intensity of approximately 8,000 µmol photons .

Model quantifiers

I(t) – irradiance (µmol photons m s )
The FIRe illuminates the sample volume using LEDs. It measures the generated light intensity, and
outputs it as a time resolved excitation profile.

– functional absorption cross section of PS II ( )
The functional absorption cross section measures the ability of the photosynthetic apparatus to
harvest light from the environment. Under illumination, reaction centers can absorb a photon to
enter a chemically reduced state. These reduced centers are no longer able to absorb photons, and
are effectively closed to further absorption.

C(t) – ratio of closed RC II
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Theoretically, a dark-adapted sample initially has no closed reaction centers. Under illumination,
reaction centers will absorb a photon, and become chemically reduced; this means they are closed
to further reduction. C(t) lies between zero (none closed) and one (all closed).

p – connectivity factor
When reduced RC IIs are illuminated, they can pass the excitation to surrounding, non-reduced RC
IIs. The connectivity factor measures the magnitude of this effect on a zero to one scale; at p=0, the
effect is not present, at p=1, all light absorbed by closed centers is passed on until it reaches an
open center. For a given absorption cross section, the higher the p-value means faster absorption.

F(t) – fluorescence yield
When a reduced RC II is illuminated, and does not pass the absorbed photon to a connected center
(see connectivity factor), it will respond by emitting light at a wavelength longer than that absorbed
(i.e. fluorescence). The fluorescence yield is defined as the measured fluorescence divided by the
irradiance intensity. As a ratio of two light intensities, the fluorescence yield has no physical units.

– minimum fluorescence yield after dark adaption
After dark adaptation, all PSII RC’s should be open.In this state, the fluorescence of the sample has
its minimal value and is described by .

– maximum fluorescence yield after dark adaption
After sufficient irradiation, all reaction centers are reduced and fluorescence is at its maximal value
and is described by Fm. An irradiated sample reaches this state asymptotically.

– variable fluorescence yield after dark adaption
This measure describes the difference between the maximum and minimum fluorescence yields.

– photochemical efficiency of open reaction centers of PS II
provides an estimate of the quantum efficiency of photosynthetic electron transport, or

how effective the photosynthetic apparatus is at converting light energy into chemical reductant.
– reoxidation time constants (s)

When illumination stops, the excited states of the reaction centers will eventually decay back to their
ground state. Depending on the state of the closed center, the decay may proceed over one of three
possible pathways, each with its own decay time constant.

– ratio of reoxidizing components
The closed centers reoxidize via one of three pathways, and the relative frequency states is
measured by the -values. The sum of the -values must by definition be 1.

The physiological model as introduced by Kolber et. al. establishes a mathematical relation between the
irradiance intensity and the measured fluorescence. At any time, two competing processes occur:

1. Reaction centers are reduced by incoming light. The rate of the overall reduction is quantified by the
light intensity and by the functional absorption cross section.

2. Reaction centers reoxidize back into their ground state. The rate of reoxidation is determined by
three time constants.

Assuming that the dynamics of PS II are completely determined by these two processes, it is possible to
calculate the physiological parameters characterizing the sample (

) from the measured fluorescence (F(t)) and irradiance (I(t)) profiles. Numerically, this is done
by searching for those parameter values that most closely (in a least square sense) match the profile.
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Single Turnover Induction

The purpose of the Single Turnover Induction (STI) is to supply the sample with sufficient irradiation to
simultaneously reduce the PSII RC’s at . Further, the STI period must be sufficiently short so that
other chromophores are not affected and alter the fluorescence behavior of the sample. The duration of
the STI must be shorter than the time scales for reoxidation.

Ideally, a single turnover induction starts from a completely oxidized (dark adapted) state, where the
minimum fluorescence . Then, the sample is illuminated by the LEDs, causing the PSII RC’s to reduce
(close to further photons), and emit fluorescence. Optimally, the duration of a STF phase should be such
that the measured fluorescence approaches a plateau. Typical STF durations are in the 80 to 120 µs
range.

The magnitude of the fluorescence yield profile ranges from the background fluorescence ( ), which is
the height of the profile above the zero line to the maximum achieved fluorescence ), which is
asymptotically approached over time. The shape and curvature of the fluorescence yield profile
determines the functional absorption cross section ( ) and the connectivity factor (p).

The RC’s then absorb a proportion of the excitation light, and are reduced and closed to further
photochemical pathway processes. Reaction centers that are closed will emit fluorescence upon further
excitation. The relative amplitude of the fluorescence yield is a measure of the fraction of closed reaction
centers, and the induction transient of the fluorescence yield represents the time course of the closed
centers as well as the absorption cross section.

The effect of varying absorption cross section ( ), while other parameters ( ) are kept fixed,
is illustrated in the following plot. For higher the absorption cross section values, the observed
fluorescence reaches faster.
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For a given absorption cross section, variations in the connectivity (p) change the shape of the
fluorescence profile, as is illustrated in the next plot. With higher p values, the initial rise in the
fluorescence is reduced, only to accelerate further on.
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Multiple Turnover Induction

The purpose of the Multiple Turnover Induction is to supply the sample with an appropriate intensity and
length of excitation to cause reduction on the time scale of multiple reoxidation time scales. After a
sufficient time, excited reaction centers will reoxidize and then be re-reduced, potentially multiple times.
This situation forces the photosynthetic electron transport system through multiple cycles that will reduce
not only the primary electron acceptor ( ) (as in the Single Turnover Protocol), but also the
secondary electron acceptor ( ), and the plastoquinone pool (PQ). This multiple turnover protocol
operates on time scales longer than the single turnover protocols previously described (500 – 800 ms at
an integrated flash intensity of approximately 8,000 versus 100

).

Relaxation

The relaxation for both ST and MT protocols follow the same biophysical model. Ideally, relaxation follows
an induction that resulted in complete saturation, where all RC IIs are in a uniform, reduced, state. It is
assumed that three independent pathways exist for the reoxidation of reduced reaction centers (see
Kolber et.al., 1998).

Each pathway is characterized by a separate time constant ( ), and the respective contribution
of these three pathways ( ).
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Major Components

Major components of In Situ FIRe include the optical head, the main housing, and the connector end-cap.
The body and LED modules are constructed of anodized aluminum. The remainder of the optical head
and the connector end-cap are constructed of acetal plastic.

in situ FIRe body.

FIRe Optical Head

The optical head contains the pump/probe LEDs, the reference photodiodes, the fluorescence detection
optics, and the pressure sensor. The optical components are detailed below. The pressure sensor is
detailed in Ancillary Sensors .

Pump/Probe (Excitation) LEDs
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Pump and probe optical power is provided by four light emitting diodes (LEDs) mounted on each side of
the optical head. The LEDs are thermally connected to anodized aluminum heat sinks, visible on the
outside of the optical head. The standard LEDs are blue. The peak wavelength is typically 448 nm, but
can be between 440-460 nm. The emission full-width half-maximum is 24 nm. The LEDs provide a highly
uniform excitation intensity within the sample volume.

Reference Detectors

On each side of the sample volume, in the middle of the four LEDs is a reference detector that monitors
the intensity of the opposite LEDs. These detectors are shielded to prevent detection of same-side LEDs,
and spectrally filtered to minimize the effect of sunlight. The reference signal is collected simultaneously
with the fluorescent signal and is used to correct for variations both within each flash, and to account for
possible longer term variations in excitation.

Fluorescence Detector

At the bottom of the sensing area, at right angles to the LEDs is a window that receives the fluorescent
signal. Opposite this window is a removable stop that is attached to the head. The sample volume is a
cylinder limited in radius by the detector optics and in height by the distance between the detector window
and the stop. However, the field-of-view is always contained within the cylindrical sample volume.

The fluorescent signal is measured through the window at the base of the sample volume by a high
speed avalanche photodiode through a window at the base of the sample volume. The light is filtered with
a bandpass filter centered at 678 nm with a full-width half-maximum bandwidth of 22 nm. The light is
detected with a high speed avalanche photodiode. The sample volume is cylindrical, being constrained on
the bottom by the detector window, on the top by the backstop or flow cell, and around the side by the
field of view of the detector optics. These dimensions are 1 cm diameter by 2 cm, giving a sample volume
of 1.57 cm3.

To maximize the fluorescence detection, the field-of-view or numerical aperture of the detector varies with
radial position. At the center of the sample volume the field-of-view is maximum, and it decreases with
radial distance from the center. In this way the sensitivity of the instrument is maximized while maintaining
a sharp, well defined sample volume.

The APD is safe from damage in ambient sunlight. However, either the flow cell or the backstop should
always be in place. If the backstop or flow cell was in in place and the detector window was pointed
directly at the sun, damaged to the avalanche photodiode could result.
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Instrument Drawings
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External Interfaces

USB Interface

The Universal Serial Bus (USB) interface is used for both telemetry output and for FIRe configuration.
Data is transmitted from In Situ FIRe via USB when the instrument is in Acquisition Mode , and FIRe
configuration and maintenance can be performed from FIReCom when in Setup Mode .

RS-232 Interface

The RS-232 interface can be used for both telemetry output and for FIRe configuration. Although all
configuration commands are available using a simple terminal emulator (such as Microsoft
HyperTerminal), these commands are described in Command Reference.

It should be noted that a carriage return and linefeed are required from the terminal program. For
instance, in Microsoft HyperTerminal, select File -> Properties -> Settings -> ASCII Setup and check the
Send line ends with line feeds checkbox.

RS-422 Interface

The RS-422 interface can be used for both telemetry output and for FIRe configuration, similar to the
RS-232 port. The RS-422 port is designed to be used with a profiling cable.

Analog Interface

FIRe outputs Fv/Fm measurements expressed as an analog voltage ranging from 0.0 V to 4.096 V. To
convert voltage to Fv/Fm, divide it by 4.096.

Interface End Cap

The interface end cap has four bulkhead connectors.
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Connector End Cap

The four bulkhead connectors are, clockwise from left, an MCBH6M (power/RS-422), an MCBH8M
(power/USB/RS-232), an MCBH4F (analog PAR), and an MCBH4M (CTD power in/analog out)
manufactured by Subconn. The pin-out and function of each signal is described below. Please note that
in this manual, the terms RS-232/422 imply EIA 232/422.

MCBH6M 6-Pin Male Connector
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Pin Name Description

1 Vprofile Power input, 18-72 VDC

2 GND Power common

3 TX+ RS-422, data from In-Situ FIRe to
PC, positive differential

4 TX- TX- RS-422, data from In-Situ
FIRe to PC, negative differential

5 RX+ RS-422, data from PC to In-Situ
FIRe, positive differential

6 RX- RS-422, data from PC to In-Situ
FIRe, negative differential

MCBH8M 8-Pin Male Connector

Pin Name Description

1 Vin Power input, 8-18 VDC

2 GND Power common

3 USB - USB, negative differential

4 USB+ USB, positive differential

5 TX RS-232, data from In-Situ
FIRe to PC

6 RX RX RS-232, data from PC to
In-Situ FIRe

7 Vusb USB 5V

8 GNDusb USB common

MCBH4F 4-Pin Female Connector

Pin Name Description

1 GND Power common, for PAR
sensor

2 PARin Analog input, from PAR
sensor only

3 PARgnd Analog ground, from PAR
sensor only

4 Vout Power output, 12 VDC for
PAR sensor
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MCBH4M 4-Pin Male Connector

Pin Name Description

1 Vin Power input, 8-18 VDC

2 GND Power common

3 VA Analog output voltage (0 – 4.096V)
representing 4.096*(Fv/Fm )

4 GNDA Analog output common
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Ancillary Sensors
In Situ FIRe has an integrated ancillary pressure sensor. An optional external PAR sensor is also
available. See Accessories for more informaton.

Pressure Sensor

A high quality pressure sensor is integrated in the In Situ FIRe optical head. The standard pressure
sensor has a full scale of 300 bar and an accuracy of 0.05% (resolution approx. 15 cm). It is located in
close proximity to the sample volume to minimize offsets. The pressure port is visible as a small hole near
the sample volume. The sensing diaphragm is located 6.6 cm from the center of the sample volume. A
compensating correction may be applied for deployments where the FIRe is mounted perpendicular to the
water surface (vertical).

Pressure sensor inlet port on the FIRe optical head

To account for atmospheric pressure, FIReCom applies a constant tare of 10.1325 dBar to each pressure
measurement received in the data stream emitted from FIRe.

Over time, the pressure sensor may exhibit some drift in its readings. The drift is a constant offset to the
readings. The sensor can be reset as described in the Calibrate Pressure Sensor section.

In Situ FIRe - Overview

26 / 132



Accessories

Flow Cell / Dark Adaptation Chamber

The removable flow cell accessory can be pressed into the optical head in order to seal and isolate the
sample volume from the surrounding environment. With the flow cell in place, water samples can be
pumped through the the resulting sample chamber at controlled rates. The maximum pressure for the
flowcell is 140 kPa (20 psi).

FIRe flow cell accessory

The flow cell accessory is particularly useful for:
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• measuring dark-adapted samples

• preventing bio-fouling in long-term deployments

• underway flow-though operation aboard research vessels

To install the flow cell:

1. Remove the square backstop opposite the primary detector.

2. Check the the o-ring is properly seated in the groove that wraps the flow cell body.

3. Press the flow cell into place.

4. Secure the flow cell with provided retaining screws.

5. Pump some water through the cell to check for leaks.

In Situ FIRe optical head fitted with, from left, backstop, no backstop, flow cell.

If required, replacement retaining screws are 4-40, 5/16". One source is McMaster-Carr, part number
90585A203.

PAR Sensor (Optional)

In Situ FIRe has bulkhead electrical connections for a Satlantic Photosynthetically Available Radiation
(PAR) Sensor. In Situ FIRe is pre-configured to accept an analog input from a logarithmic PAR sensor.

PAR data is collected for each STF/MTF flash and processed along with the fluorescence data. The PAR
accessory allows you to relate the collected active fluorescence data with both depth (using the integrated
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pressure transducer) and available light. Further, these data can be used to compute higher-level
parameters such as electron transport rates (ETR).

Profiling Hardware (Deck Unit and Cabling) (Optional)

The MDU-300 deck unit serves as both a nominal 48 Volt DC power source for the in-situ FIRe system
and as an RS-422 to RS-232 level converter. The MDU-300 provides three connectors for data and
power as detailed below:

MDU-300 pinout

In Situ FIRe has a power requirement of approximately 7 Watts. Assuming a pessimistic 75% conversion
efficiency for the MDU-300, this system would require about 0.8 Amps from a 12 V battery. Using a large
rechargeable 12 V battery, such as a 50 amp-hour gel-cell, will provide many hours of operation and will
have sufficient power to run a laptop as well.

The Profiling Cable runs from the deck unit to the instrument body. It acts as a mechanical and electrical
tether, providing a flexible, high strength connection between the vessel and the instrument and providing
a channel to transport telemetry to the deck unit. The cable weighs approximately 740 g / 100 m (5 lbs /
1000 ft) in water. The breaking strength is nominally 725 kg (1600 lbs), and the minimum bend radius is
10 cm (4 in).

The Supply Cable or Battery Cable runs from the battery to the deck unit.

The RS-232 Cable runs from the deck unit to the computer.
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Specifications

Physical

• Operating Temperature: 0-40 C

• Dimensions: 10.2 cm (4.0 in) diameter, 50.3 cm (19.8 in) long

• Construction: Anodized aluminum and Acetal

• Weight: 3.84 kg (8.45 lb)

• Depth Rating: 200 m

Optical

• Sample Volume: 1.57 cm3 (1 cm diameter, 2 cm high)

• Excitation Source:

o Color: Royal Blue

o Peak Wavelength: 447.5 nm typical (min 440 nm, max 460 nm)

o Spectral Bandwidth: 24 nm typical (FWHM)

• Fluorescence Detection:

o Center Wavelength: 678 nm

o Spectral Bandwidth: 22 nm (FWHM)

Electrical

• Input Voltage: 8-18 VDC (using programming cable), 18-72 VDC (from MDU-300 over profiling
cable)

• Power Consumption: 12 W at startup, 6.5 W standby, 7.5 W flashing (all measured at 12 V)

Data Storage and Communication

• Storage: 4 GB flash memory

• Serial Interfaces: RS-232 and RS-422, 9600-115200 baud
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• Universal Serial Bus: USB 1.1 and USB 2.0 compatible

Ancillary Sensors

• Pressure

o Range: 30 bar

o Accuracy: 0.05%

o Resolution: 15 cm

• PAR (Optional)

o Range: 0-6500 umol photons m-2 s-1

o Dimensions: 30.5 mm (1.2 in) diameter, 76.2 mm (3 in) long

o Weight: 102 g (0.22 lb)

o Depth Rating: 600 m

Flow Cell

• Pressure Rating: 140 kPa (20 psi)
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Software
In Situ FIRe comes compete with FIReCom, a graphical software application for configuring and
controlling FIRe, and for managing and processing data.

Topics in this chapter include:

• FIReCom Overview

• Installing FIReCom

• Navigating FIReCom

• FIReCom Dashboard

• Connecting to FIRe

• FIReCom Preferences

• Message Logging
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FIReCom Overview

In Situ FIRe comes complete with FIReCom, an interactive graphic software application. Connect In Situ
SeaFET to your computer via the supplied USB programming cable to enjoy these FIReCom features:

• Review and modify FIRe operational settings

• Schedule FIRe data collection activity

• Manage and retrieve logged FIRe data

• View FIRe data in real time

• Reprocess FIRe data and graph results

FIRe provides the tools necessary to configure and operate your In Situ FIRe for any deployment
scenario. Manage on-board data storage, processing, and sampling modes. Set up real time data
streaming via USB or serial port. Capture and plot data in real time for pre-deployment checks or
interactive profiling casts. Re-process logged FIRe data for improved accuracy.
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Installing FIReCom

For the latest FIReCom software updates, please visit http://satlantic.com/firecom .

Installing FIReCom on Windows

Supported Microsoft Windows systems: XP/Vista/7/8, 32 bit or 64 bit.

Minimum recommended computer hardware:

• Processor: 2.6 GHz Intel Pentium IV or equivalent

• Memory: 2 GB

• Disk space: 1 GB of free disk space

To install the software, run the FIReCom self extracting installer program found on your FIRe product
CD-ROM or at http://satlantic.com/firecom. The installer is named in the form
FIReCom-<version>-b<build>-x86.exe (e.g. FIReCom-0.1.0-b4-x86.exe).

The installer program steps through the install process. The default option can be selected at each
confirmation step.

Installing the In Situ FIRe USB Driver on Windows 7 or Vista

The last step in the installer is to install the USB FTDI D2XX driver . FIReCom requires this to be run at
least once in order to connect via USB. On subsequent installs this step can be skipped. The installation
of the in situ FIRe USB driver causes the following dialog to be displayed:
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After the in situ FIRe USB Driver Setup dialog appears, a Windows Security dialog requests confirmation
before proceeding to install the driver:

Check the Always trust software from "Satlantic LP " option. Press the Install button to confirm trust in
software provided by Satlantic and to complete the USB-Serial driver installation.

Installing the driver multiple times should not cause any problems. If for any reason a problem occurs,
please use MS Windows Device Manager to view the status of the in situ FIRe USB driver and correct
any problems. For more information on troubleshooting this FTDI USB driver see D2XX driver (
http://www.ftdichip.com/Drivers/D2XX.htm ) page. FIReCom installs a customized USB driver currently
based on the generic FTDI USB Driver version 2.08.14.

Installing the In Situ FIRe USB Driver on Windows 8

Installing the USB FTDI D2XX driver on Windows 8 is similar to that as on Windows 7. However, two
Windows Security dialogs are displayed during the install process. The first one is shown below:

Press the Install button. A second Windows Security dialog, shown below, is then displayed.
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Press the Install button to finish the installation of the USB driver.

Installing in situ FIRe USB Driver on Windows XP

CAUTION : The FIReCom program must not be running when completing the in situ FIRe USB driver
installation on Windows XP. If FIReCom is running while installing thee In Situ FIRe USB driver on
Windows XP, the driver installation will fail.

After the driver installation steps are completed, and before FIReCom is run, the driver must be activated
by connecting the in situ FIRe to one of the computer's available USB ports. Connect the FIRe to a USB
port, then select the No, not this time and Install the software automatically [Recomended] options on the
following Found New Hardware Wizard dialogs:

Press the Next button to proceed:
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After the second dialog, another dialog is displayed to warn that the USB driver publisher can't be verified.
Select the Continue Anyway button to safely install.

Press Finish button to exit the Found New Hardware Wizard.
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Uninstalling FIReCom

Uninstalling FIReCom on Windows 7

To uninstall the FIReCom software, click on Start -> All Programs -> FIReCom-<version> -> Uninstall
FIReCom-<version> as shown in the following screenshot from a Windows 7 computer.

Press the Uninstall button on the Uninstaller to proceed with the uninstall of FIReCom.
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Uninstalling the In Situ FIRe USB Driver on Windows 7

The FIRe instrument must to be plugged into an USB port on the computer in order to uninstall the USB
FTDI D2XX driver. To begin the uninstall process bring up the Devices and Printers window from the
Control Panel as shown in the following diagram.

Right click on DLP-USB245M and click on the Properties menu item to display the DLP-USB245M
Properties dialog. Click on the Hardware tab.
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Click on the Properties button.

Click on the Driver tab.

Click on the Uninstall button.
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Click on the check box to delete the driver software and then on the OK button to finish with the uninstall
of the USB FTDI D2XX driver.

Uninstalling the FTDI USB Serial Converter Driver on Windows 7

Make sure that the FTDI USB Serial Converter driver is plugged into an USB port on the computer before
beginning the uninstall proccess. Bring up the Devices and Printers window from the Control Panel as
shown in the following diagram.

Right click on UC232R and click on the Properties menu item to display the UC232R Properties dialog.
Click on the Hardware tab.
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Click on the Properties button.

Click on the Driver tab.
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Click on the Uninstall button.

Click on the check box to delete the driver software and then on the OK button to finish with the uninstall
of the FTDI USB Serial Converter driver.

Uninstalling the FTDI USB Serial Converter Driver on Windows XP

As on Windows 7, make sure that the FTDI USB Serial Converter driver is plugged into an USB port on
the computer before beginning the uninstall proccess. Bring up the System Properties window by clicking
on System from the Control Panel. Click on the Hardware tab as shown in the following diagram.
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Click on the Device Manager button.

Right click on the USB Serial Port and then click on Uninstall.

Click on the OK button to confirm and proceed with the uninstall of the FTDI USB Serial Converter driver.
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Navigating FIReCom

FIReCom has provides a Menu for navigating all available actions, and a flexible multiple-window
interface for displaying key information relevant to the operating mode of the sensor and software.

The Dashboard Area always displays the Dashboard for connecting to In Situ FIRe. Other windows such
as the Data Processing Dashboard can also reside in the dashboard area.

The Main View Area is where larger windows such as the Time Series Graph and the Profile Sequence
Plot appear when acquiring or processing data.

The Output Area shows diagnostic console outputs from the connected FIRe and of the software
application itself.

The Status Area along the bottom of the main window shows information messages and progress reports
as the software executes various actions.

Menu
The following is a summary of all actions available on the FIReCom main menu:
FIReCom menu lists actions for setting software preferences.
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• Message Logging - edit Message Logging Settings for logging events, warnings, and errors
specific to the software.

• Preferences - set FIReCom Preferences for display, serial connection, and data directory.

• Exit - halt and exit FIReCom

Sensor menu lists actions for connecting to FIRe and configuring it for operation:

• Connect/Disconnect Serial - initiate or terminate a serial connection to In Situ FIRe. See
Connecting to FIRe for more information.

• Start Sampling - start or stop a continuous Real Time Data Acquisition on the connected In Situ
FIRe. Also starts Real Time Data Display and allows Logging Real Time Data by FIReCom.

• Start Single Sample - start acquisition of a single profile sequence on the connected In Situ FIRe.

• FIRe Settings - review and modify basic settings on the connected In Situ FIRe. See FIRe Settings
for more information.

• Edit Flash Sequences configure STF and MTF Flash Sequence Settings on the connected In Situ
FIRe.

• Flash Iteration Settings - configure Flash Iteration Settings on the connected In Situ FIRe.

• Transfer Files - use the File Manager to assist in Transferring Files from the connected In Situ
FIRe.

• Create Blank Profile - compensate for background fluorescence and the sensor noise floor by
Creating Blank Profiles .

• Ancillary Calibration - upload new PAR Sensor Calibration coefficients to the connected In Situ
FIRe.

• Sync Time - synchronize the In Situ FIRe internal clock with UTC time from the local computer. See
Clock Synchronization for more information.

• Summary Report - generate a Sensor Summary Report showing status and settings of the
connected In Situ FIRe.

• Advanced sub-menu lists actions typically used only as directed by Satlantic for remote diagnostics
and repairs.

o Command Terminal - open a terminal input to the connected In Situ FIRe to issue direct
commands as documented in the Command Line Interface .

o On Board Processing - set expert parameters for On Board Processing performed by the
connected In Situ FIRe.
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o Upload FIRe Instrument XML File - upload an Instrument XML metadata file to the connected
In Situ FIRe. See Application Files for more information.

o Upload FIRe Sequence File - upload a flash sequence file to the connected In Situ FIRe. See
Application Files for more information.

o Upload FIRe Firmware Patch File - upload a firmware patch file to the connected In Situ
FIRe. See Application Files for more information.

o Calibrate Pressure Sensor - apply a Pressure Sensor Calibration offset to connected In Situ
FIRe.

Data menu lists operations for processing and replaying logged FIRe data.

• Process Raw Data - select raw data files to process as described in Processing Raw Data .

• Replay Processed Data - select processed data files to display. See Replay Processed Data for
more information.

• Post Processing Options - modify Post Processing Options that govern processing raw data in
FIReCom.

• Advanced Post Processing Settings - expert parameters for FIReCom post processing. See
Advanced Post Processing Settings for more information.

View

• Graphs

o Sequence Graph - view the sequence of fluorescence yield profiles and reference excitation
profiles on the Real Time Data Display

o Time Series Graph - view the time series graph on the Real Time Data Display.

o Depth Profile Graph - view the depth profile graph on the Real Time Data Display

o Blank Profile Graph - view the blank profile graph. See Creating Blank Profiles for more
information.

• Output - actions in this menu show tabbed consoles in the Output area.

o Setup Console - show all output generated by In Situ FIRe as it executes commands in Setup
mode.

o Acquisition Console - show the sensor data as it is transmitted by In Situ FIRe while in
Acquisition mode. The Acquisition Console does not log acquired sensor data directly.
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o Application Console - show a log of all the actions performed by FIReCom, and any errors or
warnings when communicating with In Situ FIRe. See Message Logging section for more
information.

• Current Flash Sequence - view the active flash sequence on the connected In Situ FIRe.

• Gain Settings - view the Gain Settings panel.

• Real Time Data - view the Real Time Display panel for Monitoring Real Time Data Acquisition .

• Data Logging - view the Data Logging panel for Logging Real Time Data .

• Acquisition Monitor - view the Data Acquisition Monitor to show error statistics when Monitoring
Real Time Data Acquisition

Window - each of the following actions operates on the currently selected sub-window or panel of the
FIReCom application:

• Maximize Window - enlarge the selected panel to fit the top-level FIReCom window.

• Close Window - hide the selected panel or window.

• Undock Window - detach the selected panel from the main application and show it in its own
window.

• Close All Documents - hide all non-mandatory panels and sub-windows.

• Reset Windows - reset application window layout to the default.

Help - actions for accessing documentation and software version:

• Help Contents - show the user manual in the Help viewer with a navigable list of contents.

• Troubleshooting - show the Troubleshooting section of the manual

• Satlantic.com - visit the Satlantic web site.

• User Manual - open the printable user manual. Requires PDF reader software installed on the local
computer.

• About - show software version information.

Customizing FIReCom Layout
FIReCom provides a flexible multiple-window interface for customizing the layout of most components.
Windows can be viewed, dragged, tabbed, docked, and stretched to best suit the job at hand within the
available screen size.
To move a window to an alternate location:
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1. Click and hold the top bar on the window.

2. Drag it within its own area, or to a different area.

3. Move the window around near the desired location until an orange rectangle frame appears.

4. If the orange rectangle fully covers an existing window, the dragged window will be tabbed within it.

5. If the orange rectangle partly covers and existing window, the existing window will be resized to
make room for the dragged window to locate adjacent.

6. Release the mouse button to place the window in its new location.

To resize a window :

1. Roll the mouse pointer over an edge of the internal window until the pointer changes to a
double-ended arrow.

2. Click, drag, and release to set the new window size

To undock a window :

1. Click and hold the top bar on the window.

2. Drag it outside the area of the main window.

3. Release to undock the window into its own main window.

4. Alternately, select Window->Dock Window on the menu.

5. Select Window->Dock Window on the menu to return the window to its internally docked location
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FIReCom Dashboard
The dashboard panel in the upper left area of the main FIReCom window displays the identity and status
of the connected In Situ FIRe. It also provides a menu of buttons linked to the most commonly accessed
functions for configuring and operating In Situ FIRe.

The following information fields are populated when communication with In Situ FIRe has been
established.

• Connection Mode indicates if In Situ FIRe is awaiting commands in Setup mode, or if it is collecting
data samples in Acquisition mode, or if it is in Transition between these two modes. Disconnected
indicates that there is no active connection to In Situ FIRe.

• Connection Status indicates port connection status and whether the port is serial or USB.

• FIRe Clock Time shows the UTC time reported by the internal clock on In Situ FIRe.

• Available Disk Space indicates the amount of available on-board data storage space on In Situ
FIRe.

• Serial Number is the serial number of In Situ FIRe.

• FW Rev indicates the revision number of the operating firmware installed on Is Situ FIRe.

The bottom half of the dashboard panel lists a menu of buttons for commonly accessed functions
affecting In Situ FIRe.
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• FIRe Settings invokes the FIRe Settings dialog for changing basic operating parameters of In Situ
FIRe.

• Edit Flash Sequences starts the Flash Sequence Settings editor to configure the sampling
sequence executed by In Situ FIRe.

• Transfer Files starts the File Manager for Transferring Files from In Situ FIRe.

• Start Sampling commands In Situ FIRe to commence executing the active flash sequence until
commanded to stop.

• Start Single Sample commands In Situ FIRe to execute a single iteration of the active flash
sequence and then return to Setup mode.
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Connecting to FIRe

FIReCom can connect to In Situ FIRe via one of the three following External Interfaces :

1. USB (Universal Serial Bus) via MCBH8M connector

2. Serial RS-232 via MCBH8M connector

3. Serial RS-422 via MCBH6M connector

Each of these interfaces supports configuration, command, file transfer, and data acquisition from
FIReCom.

USB Connect
USB is the preferred connection method for using FIReCom for pre-deployment configuration and test of
In Situ FIRe. The USB interface povides significantly higher data transfer rates than serial connection and
is therefore best for Transferring Files from In Situ FIRe after long deployments.

1. Ensure that the FIReCom software and USB driver are correctly installed and activated on your
computer as described in Installing FIReCom .

2. Connect the supplied USB programming cable to the MCBH8M bulkhead connector.

3. Connect the cable power leads to a 10 V - 18 V DC power supply. In Situ FIRe will be fully started
after approximately thirty seconds.

4. Run FIReCom software.

5. Insert the Type A USB connector end of the cable into an available Type A USB socket on the
computer running FIReCom.

6. Watch the FIReCom Dashboard for indication that that the connection mode is in the Transition
state as FIReCom awaits response from In Situ FIRe. Mode will change to Setup when In Situ FIRe
is ready for commands.

Serial Connect

In Situ FIRe provides two serial ports:

1. The RS-232 port on the MCBH8M bulkhead connector is suitable for bi-directional serial connection
to FIReCom or other data logging equipment over distances of 15 meters (50 feet) or less.

2. The RS-422 port on the MCBH6M bulkhead connector is suitable for bi-directional serial connection
to FIReCom or other data logging equipment where cable length exceeds 15 meters (50 feet).

Only one of these two serial ports can be active at any one time. In Situ FIRe is normally pre-configured
with the RS-232 port as the active port, transmitting at 38400 baud. To change the active serial port,
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connect from FIReCom on the current active serial port or via USB as described above, then adjust the
FIRe Settings for active serial port and restart In Situ FIRe to apply.

To connect FIReCom to In Situ FIRe via serial port:

1. Connect the wet-mateable serial cable to the active serial port: either MCBH8M (RS-232) or
MCBH6M (RS-422). Ensure connectors are free of dirt and male pins are lightly lubricated with DC
111 silicone grease before mating.

2. Apply power to In Situ FIRe via programming cable, battery pack, or deck unit (see Accessories).
Allow thirty seconds for In Situ FIRe to start.

3. Connect the FIReCom host computer serial port to the deck unit or directly to the cable as required.
Note the operating system designation (example: COM2) of the physical serial port.

4. Select Sensor -> Connect Serial on the FIReCom main menu to show the Serial Connect dialog.

5. Select the Baud Rate that is configured on In Situ FIRe, or select Try All Baud Rates to attempt
connection on all possible baud rates.

6. Select the Port noted in step 3 above.

7. Press Connect to initiate the connection attempt. The FIReCom Dashboard should first indicate
connection mode is in the Transition an then indicate Setup when In Situ FIRe is ready for
commands.

Firmware Compatibility

When a connection is successfully establised, FIReCom identifies the firmware revision running on In Situ
FIRe and determines whether it is compatible with the software version being used.

If the detected firmware revision is incompatible, FIReCom will offer to apply a firmware upgrade:
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Press the Upgrade button to confirm and proceed. If you do not wish to upgrade the firmware on your In
Situ FIRe at this time, press Disconnect. You can continue to use the older version of FIReCom that
shipped with your In Situ FIRe.

FIReCom is unable to upgrade firmware on some older version of In Situ FIRe. The only option at this
point is to Disconnect and revert to the version of FIReCom that shipped with your In Situ FIRe:

Please Contact Satlantic to arrange a Return Materials Authorization if you wish to upgrade your In Situ
FIRe to use the latest firmware and software.
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FIReCom Preferences

To review and modify FIReCom software preferences, select FIReCom -> Preferences on the main
menu.

The Preferences dialog manages settings for the behavior of the FIReCom software. Preferences edited
in this dialog affect software behavior only. This dialog does not alter the settings on In Situ FIRe.

The following software application general preferences may be edited:

• Default Serial Port sets the default serial communications port shown in the Serial Connect dialog.
See Connecting to FIRe for more information.

• Default Baud Rate sets the default baud shown in the Serial Connect dialog. See Connecting to
FIRe for more information.

• Response Timeout sets the number of seconds that FIReCom will wait for a response from a FIRe.
This value can be increased if low baud rates or communication delays cause disconnections.

• File Listing Timeout sets the number of seconds that FIReCom will wait for a response from a
FIRe for a file listing.

• Maximum Retries sets the number of times FIReCom will send a command or attempt connection
to In Situ FIRe before giving up if no response is received.

• Data Directory identifies the local directory to which logged data will be saved.
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• Ask for directory each time FIReCom starts causes FIReCom to prompt you to specify the the
data directory every time it starts. This may be useful where multiple In Situ FIRe instruments are
alternately accessed from one computer and you wish to keep data files for each separated.

The following software application display preferences may be edited:

• Displayed Numeric Precision sets the number of decimal places to show for all floating point
values displayed by FIReCom.

• Use UTC Time instructs FIReCom to display times in the UTC (Universal Coordinated Time,
formerly Greenwich Mean Time) time zone. Otherwise, the local time zone of the host computer is
used. In Situ FIRe always records time in UTC regardless of this software interface setting,
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Message Logging Preferences

FIReCom maintains an application message log file that records diagnostic information that can assist
with sensor troubleshooting. By default, the message log captures a modest amount of diagnostic
information. The Preferences dialog's Message Logging panel configures how much diagnostic
information is recorded, and where.

The Logging Level drop-down box allows you to select the verbosity of the FIReCom application logs.
The following log levels can be selected. All log levels are cumulative, i.e. INFO level also logs WARN
and ERROR.

• TRACE is the most detailed and verbose level of logging. This generates very large log files and
should only be used as directed by Satlantic to assist in remote troubleshooting.

• DEBUG generates a high level of logging detail and is mainly used as directed by Satlantic to
assist in remote troubleshooting.

• INFO is the default log level showing information (status), warnings, and errors.

• WARN limits log messages to warnings and errors.

• ERROR only logs errors.
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Enable the Display Dialog for Error Level Messages option to cause a pop-up message to be
prominently displayed whenever an ERROR or SEVERE message is logged. Such messages are written
to the log file regardless of this setting.

The message log file does not grow unbounded. If the Daily Log Files option is selected, a new log file is
created each day. Otherwise, when the Rolling Log Files option is selected, the Maximum Size setting
determines the size at which an active log file is saved and a new one started. Once the the Maximum
Number of saved log files is reached, the oldest file is deleted whenever a new one is started.

The File Location field shows where event log files are being store on the local file system.
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Settings
This chapter describes In Situ FIRe device settings and how to manage them via FIReCom software.

Topics in this chapter include:

• FIRe Settings

• Flash Sequence Settings

• Flash Timing Explained

• Flash Iteration Settings

• Gain Settings

• On Board Processing

• Clock Synchronization

• Sensor Summary Report
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FIRe Settings

To review and modify general FIRe settings, connect to In Situ FIRe and select Sensor -> FIRe Settings
from the main menu to invoke the FIRe Settings dialog. Modify settings as desired and press the Upload
button to apply them the connected In Situ FIRe.

Serial Port Settings

In Situ FIRe has two bi-directional serial ports (as described in External Interfaces) , either one of which
can be used for both receiving commands and outputting data frames. Select either RS-232 or RS-422 to
set the active serial communications port on the instrument. Select the desired Baud Rate of the active
serial port the list of supported baud rates: 9600, 19200, 38400, 57600, 115200. Lower baud rates are
recommended for longer serial cables, particularly for deep profiling applications over RS-422 on the
MCBH6M bulkhead connector.

If the Serial Port settings have been changed when the Upload button is pressed, FIReCom displays a
message dialog to inform you that a reboot of In Situ FIRe is required. When this message has been
confirmed, FIReCom reboots In Situ FIRe to apply the new serial port settings.ls

Data Transmission Settings

In Situ FIRe transmits raw (unprocessed) data through its USB and serial port interfaces when actively
sampling. To suppress the transmission of raw data, de-select the Transmit Raw Data on External
Interfaces option.
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If Process Single Turnover Flash Data is selected below, In Situ FIRe will transmit processed data
regardless of whether or not raw data transmission is enabled.

On-Board Processing Settings
In Situ FIRe is capable of transmitting processed single turnover flash (STF) data. This can be useful for
remote deployments where an external controller may be required to periodically communicate calculated
fluorescence measurements. On-board processing is available for STF data only. Processed results for
multiple turnover flash (MTF) data must be calculated off-line by the FIReCom
Select the Process Single Turnover Flash Data option to configure In Situ FIRe to log and transmit
processed data frames in addition to raw data frames. Check the Use Blank for Processing sub-option
to configure In Situ FIRe to apply a blank profile when processing STF data.

On-Board Logging

In Situ FIRe logs all raw data samples and processed data to its large-capacity internal storage area. The
data log files generated by In Situ FIRe can be prepended with a contextual Deployment Comment
specified here.
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Flash Sequence Settings

In Situ FIRe can be programmed to excite and measure the sample volume using any sequence of
flash/relaxation phases. Each such phase in the sequence can be either an STF/STRP (single turnover
flash / single turnover relaxation phase) or an MTF/MTRP (multiple turnover flash / multiple turnover
relaxation phase).

Two constraints on sequences are imposed:

1. a sequence must contain at least one flash/relaxation phase, and

2. the first phase in the sequence may only be STF/STRP.

Many different sequences can be defined on In Situ FIRe, but only one may be active (enabled) at any
one time.

To review and/or modify flash sequence settings, ensure that In Situ FIRe is connected and in Setup
mode. Select Sensor -> Edit Flash Sequences from the main menu to show the flash sequence editor
dialog:

The top panel of the Edit Flash Sequences dialog lists the name of each flash sequence that is defined on
the connected In Situ FIRe. The sequence preceded by an asterisk (*) is the active sequence. This is the
sequence that will be executed by In Situ FIRe when its next begins sampling.

To add a new sequence, press the Add Sequence button and provide a name for the new sequence
when prompted.

To delete a sequence, select the name of the sequence on the list so that it is highlighted. Then press
Delete Sequence to delete the selected sequence.

To change the active sequence, select the sequence to enable and press the Set Active button.
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The table on the bottom pane on the Edit Flash Sequences dialog shows a the attributes of the sequence
that is highlighted in the Sequence list above. Each row on this table represents an induction/relaxation
event. These events will be executed by In Situ FIRe in the order they are listed.

Cells in the first six columns of the table are editable:

• Flash Type : select the desired type of induction/relaxation event as either STF/STRP or
MTF/MTRP.

• Induction Duration sets the duration of the induction phase in microseconds.

• Relaxation Duration sets the duration of the induction phase in microseconds.

• Initial Flash Interval sets the number of microseconds to idle between the first two flashes within
the relaxation phase of the flash. This initial interval is used to calculate the intervals between
subsequent flashes within a profile

• Flash Delay sets the number of milliseconds to pause after each execution of this event.

• Iterations sets the number of times this event should be executed before advancing to the next
event in the sequence. Note that this can be overridden by selecting Gain-dependent Iterations in
the Flash Iteration Settings dialog.

• Total Duration is a read-only field that shows the total number of microseconds spent in the
induction and relaxation phases, not including flash delay. It is expressed as ( Induction Duration +
Relaxation Duration) x Iterations .

To add a new flash event to the sequence, press the Add Flash button and then adjust the flash event
attributes as desired. Press the Flash Up or Flash Down button to change the position of the selected
flash event relative to others in the sequence. To delete a flash event, select the event so that it is
highlighted, then press the Remove Flash button.

See Flash Timing Explained for a more in-depth explanation of how In Situ FIRe executes induction and
relaxation flashes.
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Flash Timing Explained

Single Turnover Induction

The length of the single turnover induction is user-specified. For the induction phase, the fluorescence
signal passes through a low-pass filter and is sampled at instantaneous points in time with a 1 µs
repetition period. Preceding the induction phase, 14 dark samples are recorded. The first three dark
samples are discarded and the remaining points are included in the data frame. During pre-processing a
dark correction is performed by subtracting the average dark value from each of the subsequent induction
points.

Multiple Turnover Induction

For multiple turnover induction, approximately 5 µs LED flashes are generated with a period of 44 µs. The
fluorescence signal passes through a low-pass filter and is sampled at instantaneous points in time with a
2 µs period. For each flash, 12 samples are taken, 9 before the LED flash (dark samples) and 3 during
the flash (light samples). The first and last dark samples are discarded and the remaining darks are
averaged. Only the middle light sample is used; it corresponds to when the flash has reached its peak
value. The dark average and light value are included in the data frame. No subtraction occurs until dark
correction during pre-processing. In pre-processing, the dark average for each flash is subtracted from
the associated light value.

The number of samples from a multiple turnover induction can be larger than the available high-speed
memory used to capture the samples. In these cases the flashes are subsampled (i.e. every second or
third flash, as required).

Relaxation

Before relaxation timing starts, there is a fixed delay of 14 µs. After that, the intermittent flashes begin to
measure reoxidation. The period of the flashes begins at the user-defined initial flash interval or period.
The period increases by 3-times after 600 µs, 15-times after 2400 µs, and 100-times after 11400 µs (if
required). The changing period allows the system to best capture the rapid decay of the signal at the
beginning of relaxation while reducing the amount of data at the tail end of the signal where there is little
change. Within each flash period, a dark reading is taken, followed by a reading with the LEDs on. Each
reading is an integration over 1.8 µs. When the LED is on, it is for 1.1 µs in the middle of the sample time.
Both the dark and light value are included in the raw frame. No subtraction occurs until dark correction
during pre-processing. In that case, the average of all dark points is subtracted from each light point.

Reference Signal

For each of the final data points generated above, a similar reference data point is also generated. The
reference signal measures the intensity of the LEDs with two photo diodes mounted in the middle of the
LEDs and pointing at the LEDs on the opposite side of the sample volume. The signals from the two
photo detectors are summed and processed in the same way as the fluoresce signal. They are sampled
at exactly the same time as the fluorescence data. The resulting reference data first normalized to the
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maximum value and these data are then used to scale the fluorescent signal. In this way the fluorescence
data accounts for any short and long term variations in LED intensity.

Autogain

When autogain is selected, the system uses pre-set STF parameters. It starts at a gain of 5 and increases
or decreases the gain as required until it finds an optimum gain value, defined as the gain that generates
an Fm value closest to 4000 counts. FIRe then switches to the user-defined parameters and begins the
user-defined flash sequence.
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Flash Iteration Settings

In Situ FIRe can be configured to average multiple flash iterations for a given sample in order to reduce
signal noise.

Select Sensor -> Flash Iterations Settings from the main menu to set the number of iterations to be
taken during the collection of a profile. The number of iterations is either dependent on the Flash
Sequence Settings or on the gain level. In the latter case, the number of iterations can be specified for
each gain level in the Gain-Dependent Iterations table.
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Gain Settings

Gain is a measure of the ability of In Situ FIRe to amplify the fluorescent signal collected from a sample.
To accommodate a wide range of Chl-a concentrations in natural phytoplankton and laboratory cultures,
the electronic gain of the detector unit is adjustable over a range of four orders of magnitude. The gain
can be varied using 10 preset values, nominally referred to as Level 1 to Level 10. The actual electronic
gain is an exponential function of these gain levels.

To modify gain settings, ensure that your FIRe is connected and in Setup mode, then select View -> Gain
settings from the FIReCom menu to display the Gain Settings panel in the lower portion of the dashboard.
All changes made to gain settings in this panel are immediately applied to the connected FIRe.

Auto Gain Setting

In Situ FIRe can be configured to use collected profiles at the start of each sampling sequence to
determine an optimal gain for a specific sample. It does this by sampling, examining the results, adjusting
the gain and re-sampling. This process is continued until an optimal gain is determined.

When the Auto Gain option is selected, In Situ FIRe applies pre-set STF parameters. It starts at a gain of
5 and increases or decreases the gain as required until it finds an optimum gain value, defined as the
gain that generates an Fm value closest to 4000 counts. FIRe then switches to the user-defined
parameters and begins the user-defined flash sequence.

In Situ FIRe is normally configured to sample over several iterations as specified for each flash event per
the sequences defined in the FIRe Settings dialog. Alternately, the number of iterations can be set to be
gain-dependent instead of sequence dependent. Press the Iterations button to invoke the Flash Iteration
Settings dialog to explicitly set a specific number of iterations for each gain level.

Manual Gain Setting

To explicitly set the sensor gain to a specific level, select the Manual Gain option then select the desired
level. Gain can be set to Level 1 (minimum gain) to Level 10 (maximum gain).

Relative Gain Levels

The gain settings in FIReCom are expressed as levels. Use the table below to derive relative gains from a
given level setting:

Gain SettingRelative Gain (dB)Relative Gain
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Level 1 0.0 1.00
Level 2 4.4 2.78
Level 3 8.9 7.74
Level 4 13.3 21.6
Level 5 17.8 60.0
Level 6 22.2 167
Level 7 26.7 464
Level 8 31.1 1292
Level 9 35.6 3594
Level 10 40.0 10000
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On Board Processing

In Situ FIRe analyzes measured fluorescence profiles according to the the model described by Z. S.
Kolber, O.Prasil, and P. G. Falkowski, Measurements of variable chlorophyll fluorescence using fast
repetition rate techniques: defining methodology and experimental protocols , Biochimica et Biophysica
Acta 1367 (1998) 88-106.

The on-board profile analysis provides a quantitative characterization of the investigated sample via the
functional cross section, the quantum yield, and other values.

The following In Situ FIRe on-board processing settings are intended for advanced expert users only.
Modification of these options can drastically change the output of on-board processing routines. It is not
recommended they be changed unless fully understood.

To modify expert parameters of the on-board processing algorithm, ensure that In Situ FIRe is connected
and in setup mode. Then select Sensor -> Advanced -> On Board Processing to show the settings dialog.
Enter the desired parameters then press Upload to apply.
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Clock Synchronization
In Situ FIRe has an internal system clock that is used for time-stamping logged data samples and
diagnostic messaged. This clock can drift slightly over time depending on environmental conditions. It is
recommended to synchronize the internal clock between deployments when connected with FIReCom.

To check the internal clock time and to synchronize it with the local computer, ensure that In Situ FIRe is
connected and in setup mode. Select Sensor -> Sync Time from the main menu. The Sync Time dialog
that appears shows the Instrument Time of the internal clock and the Computer Time of the local
computer. FIReCom always displays both times in UTC (Universal Coordinated Time) regardless of the
time zone settings on the local computer.

Press the Sync Time button to set the internal clock on In Situ FIRe to match the time on the local
computer.
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Sensor Summary Report

FIReCom can generate a Summary Report of settings and diagnostics retrieved from the connected In
Situ FIRe . It is strongly recommended to create a summary report before and after deployment to serve
as a contextual record for data collected during the deployment.

To generate a summary report, ensure In Situ FIRe is connected and in setup mode. Select Sensor ->
Summary Report from the main menu to show the report creation dialog. Provide any relevant contextual
information in the Summary Report Comments section. Check the View Report option if a PDF reader is
installed and you wish to view the report immediately after it is created. Press Save Report to create and
save the summary report.
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Deployment
This chapter describes various deployment scenarios and how to configure and operate In Situ FIRe for
each.

Topics in this chapter include:

• Deployment Procedures

• Creating Blank Profiles

• Pressure Sensor Calibration

• Real Time Data Acquisition

• Real Time Data Display

• Logging Real Time Data

• Monitoring Real Time Data Acquisition

• PAR Sensor Calibration

• Application Files
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Deployment Procedures

Profiling Mode

For most profiling applications, the preferred method of connecting In Situ FIRe to deck-side power and
data communications is via the optional 6-conductor RS-422 profiling cable and MDU-300 deck unit as
described in Accessories . The RS-422 communications protocol allows the use of a long deployment
cable through the entire range of the FIRe pressure rating (200 m). The USB connection is limited by
cable length (1.5 meters) and is inappropriate for a profiling situation. The RS-232 connection can be
used for profiling but this telemetry protocol limits cable length to approximately 50 m.

Prior to operating the FIRe in a profiling application, run the FIReCom software on a computer and
connect it to the instrument via the supplied USB programming cable. After FIReCom reports connection
to the FIRe, open the FIRe Settings dialog and set the following:

• Enable Transmit Raw Data on External Interfaces check box

• In SerialPort section, select Active Port to match the selected connection (RS-232 or RS-422).

• For long cable RS-422 profiling, recommended baud rate is 9600

• Save a Summary Report to record and review device status and settings

After applying above settings, save a Summary Report to record and review device status and settings.
Then remove USB and power. Leave In Situ FIRe powered off for at least 20 seconds and then restart
the instrument. Connect the RS-422 cable to FIRe and connect the deck unit to a computer running
FIReCom software. Wait 60 seconds after re-powering In Situ FIRe then use FIReCom to establish a data
connection. Observe data as it is emitted in real time to confirm that In Situ FIRe is configured correctly.

In Situ FIRe can be mounted on a profiling cage or lowering frame. Be sure to protect the the exterior
housing from damage due to metal clamps or brackets. Damage to the anodized surface of the
instrument can result in corrosion problems. Ensure that dummy plugs are installed and tightly sealed on
unused connectors to prevent in-water shorting.

The FIRe should be rinsed thoroughly with fresh water after retrieval to avoid corrosion.

Moored Deployment

In Situ FIRe is capable of logging data internally, but it does not have self-scheduling ability with a
low-power sleep mode. It therefore relies on external scheduled power control for long-term deployment
where periodic sampling bursts separated by power-saving dormant periods are required.

The 8 pin male connector on the FIRe is used to power the instrument with an 8-18 Volt DC power
source. The ideal scheduled power source is data logger such as a Satlantic STOR-X that can control
power cycling to the FIRe. In Situ FIRe requires a 60 second warm-up time before it can begin logging
and transmitting data. It is important to configure the scheduled power source so that this 60 second
delay is taken into account before any external data collection takes place.
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The 8 pin male connector also provides bi-directional RS-232 serial communication. If connecting the
FIRe to a serial data logger, the 8 pin male connector can be used exclusively for both power and
communications. In Situ FIRe will report the serial data frames as outlined in the Data Format Reference
section of this manual.

In Situ FIRe has an analog interface available on the 4 pin male connector. If you choose to use this
interface, a second cable will have to be connected to the FIRe. This analog output provides an analog
voltage output signal equal to 4.095*Fv/Fm. This feature can be used if your data logger has an ADC that
can accept this voltage range. Refer to your data logger’s manual and software for calibration of the ADC.

Prior to operating In Situ FIRe in a moored application, run FIReCom software on a computer and
connect it to the instrument via the supplied USB programming cable. After FIReCom reports connection
to In Situ FIRe, open the FIRe Settings dialog and set the following:

• Enable Transmit Raw Data on External Interfaces check box

Save a Summary Report to record and review device status and settings. Then disconnect and apply
power to the device to test internal data logging and/or telemetry transmission to an external logger.
When mounting In Situ FIRe, be sure to protect the exterior housing from damage due to metal clamps or
brackets. Damage to the anodized surface of the instrument can result in corrosion problems. Ensure that
dummy plugs are installed and tightly sealed on unused connectors to prevent in-water shorting.

Flow Cell

The flow cell is meant for gravity-fed flow through applications at low pressures (up to 20 psi). The flow
cell and backstop are interchangeable. The same screws are used to secure both items in place. Flow
rate should be considered; if flow is too low the sample may become photo-quenched or damaged and if
the flow rate is too high then the proper excitation dynamics may not be observed. If we assume 0.5 s
between flashes and a 1 cm wide sample volume, then flow rates of 1 to 1.5 meters/minute are fine,
allowing the sample volume to be replaced between flashes.

The flow cell is installed by sliding or wiggling it into place slowly. As it moves into place, watch that the
o-ring does not buckle and get pinched. This can happen easily with a new o-ring, but after an o-ring has
been seating in the flow cell groove for a time, it should not be an issue. After the flow cell is fully seated,
the four holding screws must be installed to prevent leaks.

In Situ FIRe - Deployment

76 / 132



When filling the flow cell, it should be noted that air will get trapped in the top of the flow cell if the
instrument is horizontal. The FIRe should be tipped vertically to remove the air pocket. If the air pocket is
not removed, it will change the optics of the sample chamber.

When taking blank measurements with the flow cell, no flow is necessary. Vinyl caps are provided to
cover the ends of the barbed elbows to eliminate stray light from the sample volume.

To install a new o-ring on the flow cell, it should first be softened and stretched slightly by hand. Wetting
the o-ring grove and the o-ring help to keep it seated. When in place the flow cell can be installed on the
FIRe. Leaving the flow cell in place for a period of time will allow the o-ring to assume the new shape and
will prevent it from falling off the flow cell.

CAUTION: Do not grease the o-ring as the grease may fluoresce.

Blanks

Offsets in the measured fluorescent signal will cause errors in the calculated Fv/Fm errors, due a change
in the value of Fm. Offsets will always be present due to the electronic noise floor as the fluorescent
signal is amplified. There may also be contributions from dissolved fluorescing entities (e.g. CDOM) that
may be present in the solution. The effect off this offset is noticeable at gains of about 5 and is very
significant at the highest gains.

A blank measurement is most accurate when using a filtered sample of the seawater (or media) in which
you are working. This will capture any dissolved fluorescing entities (e.g. CDOM) that may be present in
the solution. Care should be taken with the filtering process, so as to not rupture the cells, releasing
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additional chlorophyll into the blank. If access to filtered seawater or culture media is restricted, and the
samples are known to have negligible CDOM, ultra-pure de-ionized water may be used as a substitute.

The first step is to make sure the windows are completely free of grease or oils that can fluoresce. We
recommend collecting some data (either as a regular data collection or as a blank collection) first with
ultra-pure de-ionized water and a gain of 10. Fill the flow cell with the water, tip the FIRe vertically to
remove trapped air and continue filling. Place caps over the elbow-fittings to eliminate stray light. Note the
number of counts at the end of the induction. Then remove the flow cell, clean the windows again and
repeat the process. Keep repeating the process as long as the counts are decreasing.

Next, replace the de-ionized water with the prepared blank medium. Again, be sure to remove any
trapped air from the flow cell. The FIReCom interface for collecting blanks is described in the Creating
Blank Profiles section. The blank signal should be flat through the induction with no visible rise at the
beginning of the induction. If there is a rise, it indicates that there are still living cells in the sample and it
should be filtered further.

When processing data, a complete set of blank files should be available (i.e. one for each gain). If
onboard processing is used, for instance if an analog output is used, then the blanks must be collected
before deployment. Otherwise the water samples could be collected along with the FIRe deployment and
used to generate blank data afterwards. New blank files should be generated any time it is believed that
the water properties have changed. In a moored application, this may mean collecting water samples
periodically. In a profiling mode this may mean collecting water samples at different depths.

Light and Dark Adapted Measurements

The method by which the samples are supplied to In Situ FIRe allows different physiological paremeters
to be measured. This section is not meant to cover all of the possibilities in detail, but to inform the user
about different considerations when using the FIRe.

Dark adapted measurements, to measure Fo, Fm, along with Fv/Fm and other calculated values, can be
made in a couple different ways. The first way would be to make measurements at night. The second way
is to use the flow cell. The flow cell and barbed fittings are lightproof. In a moored application, a small
pump could pull water into the sample volume and allow it to become dark adapted before turning on the
FIRe and making a measurement. In the lab, if a lightproof storage container and tubing are used, then
the samples can be gravity fed through the system. In all cases, an extended dark adaptation may be
necessary.

For natural light adapted measurements, the FIRe can be used in situ during the day to obtain Fo', Fm'
and Fv'/Fm' and other values, as well as steady state fluorescence F' (or Fs). Care should be taken to
ensure the cells are illuminated at the ambient PAR prior to measurement. If the instrument is profiling
alone and there is no shading by the ship, then this condition should be satisfied. If the FIRe is mounted
on a CTD rosette, then it should be mounted on the top to minimize shading by the rosette. You should
fully consider the details of the short-term history of the water before the measurement to ensure the
results are as expected.
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Creating Blank Profiles
In Situ FIRe is able to create blank profile samples that can be applied during processing to account for
any offsets in the fluorescence measurement caused by both background fluorescence in the sample and
the FIRe noise floor. Blanks are necessary to obtain correct Fv/Fm values and are most important at
higher gain levels. A more detailed description of what a Blank sample is and why a blank sample might
be required is described in the Deployment Procedures section.

To create a blank profile, ensure that In Situ FIRe is connected and in setup mode. Select Sensor ->
Create Blank Profile from the main menu. In the Configure Blank dialog, enter the number of Iterations to
be used during the blank samples collection. The induction duration, relaxation duration, initial flash
interval, and flash delay of the first STF defined in the active flash sequence are used to configure the
blank. Sequences are explained in the Flash Sequence Settings section.

The dialog offers a choice between collecting a single blank profile or collecting a blank at each of the ten
gain settings. The currently set gain setting is used when collecting a single blank profile. The
configuration of the gain settings is described in the Gain Settings section.

The Configure Blank dialog offers a choice between collecting a Single Blank Profile or collecting A
Blank Profile for each Gain Level . The currently-set gain setting is used when collecting a single blank
profile. The configuration of the gain settings is described in the Gain Settings section.

A blank measurement is most accurate when using a filtered sample of the seawater (or media) in which
you are working. This will capture any dissolved fluorescing entities (e.g. CDOM) that may be present in
the solution. Care should be taken with the filtering process, so as to not rupture the cells, releasing
additional chlorophyll into the blank. If access to filtered seawater or culture media is restricted, and the
samples are known to have negligible CDOM, ultra-pure de-ionized water may be used as a substitute.

Blank Profile File Display

The Create Blank Profile action commands In Situ FIRe to create a blank profile file. FIReCom then
retrieves the new blank profile file and displays it in the Blank Profile Plot window. When collecting a blank
profile for each gain level, all ten are plotted and can be reviewed and verified one at a time.

Saved blank profile files can be applied when processing raw data on In Situ FIRe or when processing
logged raw data with FIReCom.
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Pressure Sensor Calibration

The offset value of the In Situ FIRe internal pressure sensor calibration can drift. This offset can be
corrected with an independently measured local atmospheric pressure reading in kPa. Connect to FIRe
via FIReCom, then select Sensor -> Advanced -> Calibrate Pressure Sensor from the main menu. Enter
the local atmospheric pressure measurement in kPa then press OK to apply the correction.

In Situ FIRe - Deployment

81 / 132



Real Time Data Acquisition
FIReCom can be used to display data collected in real-time by the connected In Situ FIRe. This real-time
data display can assist in setting up and verifying In Situ FIRe before a long-term deployment, or to
provide real-time feedback when interactively sampling.

Configuring In Situ FIRe for Acquisition

In Situ FIRe can collect data for two distinct types of profiles:

1. MTF (Multiple Turnover Flash) and

2. STF (Single Turnover Flash).

These two flash types are described in the Princple of Operation section above. FIReCom allows you to
configure the order in which STF and MTF profiles occur. By default, FIReCom is configured with a simple
STF, MTF repetitive cycle or sequence. You can adjust the number of profiles, profile types and the
settings for each profile within acquisition sequences via the Flash Sequence Settings dialog.

Starting an Acquisition

The main purpose of In Situ FIRe is to measure fluorescence.

• When In Situ FIRe is powered up it will automatically go into acquisition mode. The way in which it
will process frame data will depend upon how the instrument is configured.

• When a FIRe is powered and FIReCom is running the FIRe can be put into Setup mode by
connecting to USB or by connecting to a serial port and pressing the connect button. From Setup
mode an acquisition with real time display can be started by pressing the Sample button on the
FIReCom Dashboard . A description of the real time display acquisition is provided below.

When starting an acquisition within FIReCom, the Real Time Display allows monitoring of the generated
data. Before deployment it is advisable to confirm that the generated data are within the expected range.

Selecting Sensors for Displays

Each Configure Display dialog allows you to select which raw frame and processed frame sensor values
will be displayed within the Real Time Display , Time Series Graph and Depth Profile Graph windows.
The sensors selected for each display are stored locally and are maintained even when FIReCom is
restarted. Separate selected sensor lists are maintained for the Real Time Display , Time Series Graph
and Depth Profile Graph windows.
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Illustration: Configuration for acquisition, time series, and depth profile sensor displays.

Each Configure Sensor Settings dialog displays the frame definitions contained in the FIRe instrument
package file. Sensors can be selected for display using a mouse by either clicking the check box next to a
sensor or clicking the check box next to a frame definition. For the Time Series Graph and Depth Profile
Graph , a limited number of sensors should be selected so that the graphs created for each selected
sensor are not too small.
The following table describes which sensors are available for each FIRe frame definition. Detailed sensor
descriptions are specified in the Data Format Reference section of this manual.

FIRe Raw Frame PAR, Voltage, Pressure
FIRe Processed STF Frame F o , F m , F v , F v /F m , p , , abs , LED, ETR,

PAR, Voltage, Pressure
Post Processing STF Frame F o , F m , F v , F v /F m , p, , abs , LED, ETR,

[3], [3] PAR, Voltage, Pressure
Post Processing MTF Frame F o , F m , F v , F v /F m , LED, ETR, [3], [3],

PAR, Voltage, Pressure
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Real Time Data Display

FIReCom can display sensor data values from raw and processed STF data frames transmitted in
real-time by a connected In Situ FIRe. The same FIReCom windows can also display raw and processed
STF and MTF data frames when data files retrieved from In Situ FIRe are re-processed.

Sequence Plot

To view a sequence of fluorescence yield profiles and reference excitation profiles, select View -> Graphs
-> Sequence Graph from the main menu to show the The Sequence Plot window in the top right quadrant
of the application. This graph plots dark-corrected sensor counts representing the voltage output directly
proportional to the amount of light reaching the avalanche photodiode.

Real Time Display

To see an updated tabular view of the most recently acquired sensor values:

1. select View -> Real Time Data to show the The Real Time Display panel

2. press the Select Sensors button to select which sensor values should be displayed
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Time Series Graph

Select View -> Graphs -> Time Series Graph from the main menu to display selected sensor data values
plotted vs time. Press the Select Sensors button to select which sensor values should be plotted in the
time series graph.
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Depth Profile Graph

Select View -> Graphs -> Time Series Graph from the main menu to show sensor data values plotted vs
depth. Press the Select Sensors button to select which sensor values should be plotted in the depth
profile graph.
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Zooming and Panning Graphs

The Time Series Graph and the Depth Profile Graph provide several mechanisms for zooming and
panning the displayed data:

• Press the Zoom In or Zoom Out buttons to zoom on the plotted data around the date center point.

• Press the Auto Range button to reset the graph so that the whole data range is visible.

• Check the Axis options to zoom on one or both axes. If neither is checked, the zoom buttons are
disabled.

• Click on an individual sub-graph to limit domain/range zooming to that graph only. Click outside the
individual sub-graphs to restore domain/range zooming to all graphs.

• Press and hold the left mouse button while dragging the mouse pointer from left to right within a
graph. Release to zoom in on the selected area.
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• Press and hold the left mouse button while dragging the mouse pointer from right to left to zoom out.

• Right-click over the graph to select from a menu of zoom operations.

• To pan the view, place the pointer on the graph, then press and hold Ctl (Windows) or Alt (Mac)
while holding the left mouse button. Drag the mouse to the desired view then release the mouse
button.
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Logging Real Time Data

In Situ FIRe has ample internal storage to log months or even years of sensor data, which is ideal for
autonomous deployment. For interactive tethered operation such as a profiling cast or pre-deployment
test, FIReCom can be commanded to log a copy of the sensor data as it is transmitted to the host
computer in real time.

To log real time data to the local computer:

1. Ensure that In Situ FIRe is connected and ready in Setup mode as described in Connecting to FIRe
.

2. Select View -> Data Logging on the main menu to show the Data Logging panel.

3. Press the Start Sampling button on the FIReCom Dashboard to initiate a Real Time Data Acquisition
.

4. Press the Start Log button on the Data Logging panel to begin logging acquired data to a local log
file.

5. When the desired amount of data is logged, press the Stop Log button to stop logging data and
close the active log file.

For every data logging action, FIReCom creates two separate log files:

1. A file with suffix .raw containing raw, unprocessed data

2. A file with suffix .pro containing STF data processed on-board In Situ FIRe.
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Additional logging options are available to control how much data to log, and how to store it on the local
computer. Press the Logging Options expander icon to set the following options:

• Log File Prefix specifies an optional text prefix to be prepended to name of each log file saved.

• Log Directory sets the directory on the local computer to which log files should be saved.

• Log Duration , when selected, causes logging to automatically stop after the specified duration in
hours:minutes:seconds.

• Log Interval , when selected, causes FIReCom to pause for hours:minutes:seconds specified
between closing the last log file and opening a new one.
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Monitoring Real Time Data Acquisition

FIReCom displays data acquisition statistics when acquiring data in real time from a connected In Situ
FIRe, or when processing and replaying data from previously logged files. Overall acquisition statistics
are displayed in the Real Time Display panel. Cumulative statistics for each of the data frame types are
displayed in a table on the Data Acquisition Monitor panel.

To display overall statistics for the active acquisition, select View -> Real Time Display from the main
menu. Then press the Acquisition Information icon to expand the statistics panel below.

The following fields are updated with each frame of data acquired:

• Acquisition Statistics title indicates the serial number of In Situ FIRe from which data is being
acquired.

• Time Stamp shows the date and time (UTC) of the most recently acquired data frame. For a
real-time acquisition direct from In Situ FIRe, this time is generated by the local computer clock. For
acquisition from a previously logged data file, the time stamp is retrieved from the data file.

• Frames Read indicates the total number of complete data frames successfully acquired.

• Lost Bytes is a running count of the total number of nonassignable bytes received between
complete data frames. This number will can be expected to increment at the start of an acquisition if
a partial frame is received before the first complete frame is identified. If lost bytes are consistently
reported between all frames acquired, the most likely cause is a mismatch between the Instrument
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Package File that describes the data frames, and the data itself. Lost bytes can also indicate signal
corruption due to faulty connectors or electromagnetic interference.

• Frame Errors shows a cumulative count of errors detected in the sensor data itself. An error can be
counted for any number of reasons including a failed check sum, frame counters appearing out of
sequence, status errors, or mathematical errors when converting to physical units.

Press the Error Details button to show the Data Acquisition Monitor , which displays a summary of data
acquisition statistics for each of the data frame types being acquired.

Each row of the table on the Data Acquisition Monitor panel provides cumulative acquisition statistics for a
single data frame type.

• Frame Id is the unique identifier of the data frame type as defined in the Instrument Package File .

• Read is the number of valid frames of the listed frame type that have been read during an
acquisition.

• Errors is the number of frames that contained one or more errors.

• Checksum Errors is the number of frames that contained check sum errors, typically discarded.

• Counter Errors is the number of frames that contained counter errors, typically not discarded.

• Status Errors is the number of frames that contained status errors, typically discarded.

• Fitting Errors is the number of frames that contained fitting errors, typically discarded.
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PAR Sensor Calibration

The optional PAR sensor is factory-calibrated at Satlantic and pre-configured for In situ FIRe. In the event
that your PAR sensor is recalibrated or replaced, connect to In Situ FIRe via FIReCom and select the
Sensor -> Ancillary Calibration menu to input the PAR sensor calibration coefficients provided by
Satlantic. Press Upload to apply the coefficients.
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Application Files

FIReCom and In Situ FIRe use several different application files to define sensor data formats, flash
profile sequences and application configurations.

Instrument XML File

Your In Situ FIRe is pre-configured with an Instrument XML (eXtensible Markup Language) file that
describes the data frame and sensor definitions for your specific instrument. When FIReCom connects to
In Situ FIRe , it retrieves this instrument file so that it can correctly acquire and display data.

You should not normally need to manage or modify the Instrument XML file on your In Situ FIRe. In the
event that you are directed by Satlantic to install a new instrument XML file, select Sensor -> Advanced ->
Upload FIRe Instrument XML File to upload the spplied XML file to In Situ FIRe.

Flash Sequence File

Your In Situ FIRe is pre-configured with a default flash sequence file. You can define addtional flash
sequences via the Flash Sequence Settings dialog. The Sensor -> Advanced -> Upload FIRe Sequence
File function is mainly used to upload a custom sequence file if provided by Satlantic staff.

Upload Firmware Patch File

This function is used to upload a firmware update or patch to In Situ FIRe. Only use this function if
directed to do so by Satlantic support staff.

Application File Locations

Application files are downloaded by FIReCom and stored locally. The folder used to store application files
is platform specific. See the table below for default locations.

System Application Folder

Windows XP C:\Documents and Settings\%USERNAME%\My Documents\Satlantic\FIReCom X.X

Windows Vista C:\Users\%USERNAME%\My Documents\Satlantic\FIReCom X.X

Windows 7 C:\Users\%USERNAME%\My Documents\Satlantic\FIReCom X.X

Windows 8 C:\Users\%USERNAME%\My Documents\Satlantic\FIReCom X.X

FIReCom also stores its application log in this directory. See section Message Logging for more
information on these log files.
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Data Recovery and Processing
This chapter describes post-deployment activities for retrieving internally logged data and processing it.

Topics in this chapter include:

• Transferring Files

• Data Processing

• Processing Raw Data

• Post-Processing Options

• Advanced Processing Settings

• Replay Processed Data
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Transferring Files

In Situ FIRe stores raw data files, processed data files, blank profiles, and message logs on its internal
drive. The FIReCom File Manager provides an easy way to manage these files on the device. The file
manager shows four tabbed panes, each for listing and transferring a specific type of file:

• Raw data files

• Processed data files

• Blank files

• Log files

To retrieve files from In Situ FIRe:

1. Ensure that In Situ FIRe is connected and in Setup mode.

2. Press the Transfer Files button on the FIReCom Dashboard.

3. Select the tab listing the type of file to transfer (exampled: Raw Data Files )

4. Click to select desired files on the Instrument filesystem list, or press Select all .

5. Click the left-arrow to begin transferring selected files.

6. Optional: after confirming successful transfer to the local computer, press the Delete button to
remove the files from FIRe to free up internal storage space.
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Local File Locations

FIReCom uses files to define frame definitions, profile sequence and application configurations. These
files are downloaded by FIReCom and stored locally.

Their local location is platform specific, see the below table for their default location.

System Application Folder

Windows XP C:\Documents and Settings\%USERNAME%\My Documents\Satlantic\FIReCom X.X

Windows Vista C:\Users\%USERNAME%\My Documents\Satlantic\FIReCom X.X

Windows 7 C:\Users\%USERNAME%\My Documents\Satlantic\FIReCom X.X

Windows 8 C:\Users\%USERNAME%\My Documents\Satlantic\FIReCom X.X

It is important to manage instrument package files so that they can be used for file post processing.
These files define instrument configuration at the time of the data collection. Sequence
files(fireSequence.xml) and Session Files(FIRe_SESSION.ser) are only used by FIReCom for display and
are not critical to maintain.

FIReCom also stores its application log in this directory, see section FIReCom Message Logging for
more information on these log files.
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Data Processing

In Situ FIRe collects data profiles per the protocol introduced in Z. S. Kolber et. al.: Measurements of
variable chlorophyll fluorescence using fast repetition rate techniques: defining methodology and
experimental protocol , Biochimica et Biophysica Acta 1367 (1998) 88-106. FIReCom derives
physiological parameters defined in that publication from such profiles.

Before the parameters are estimated, FIReCom normalizes the fluorescent signal with the reference
excitation signal. Each fluorescence datum is divided by the associated reference excitation datum and
multiplied by the maximum reference excitation for the flash. In this way both short term intra-flash and
long term variations in excitaiton intensity are accounted for.

FIReCom implements an estimation algorithm to find parameter values that best match a given profile (in
the least square sense). The estimation is an iterative search, with subsequent steps closing in on
increasingly better parameter estimates. However, depending on the quality of the measured data and
some intentional randomness, a search may run into a dead end. When a search has not converged after
the Maximum Iterations per Estimation , a new estimation is started using slightly different initial
conditions.

Since the parameter estimation algorithm is non-deterministic, there is no guarantee that a good
parameter set will be found. However, tests with many types of measured and artificial data have shown
that attempting at least 40, but preferably 50 or up to 100 independent estimations ( Number of
Estimations in the Advanced Processing Settings section), will find parameters close to the true
parameters.

Besides using the Maximum Iterations per Estimation , the operator can shorten or lengthen the searches
by increasing or decreasing the Estimation Tolerance . The tolerance is a measure of the expected
precision of the search result. Reasonable values are in the 0.0001 to 0.2 range. Here, a large value is
acceptable when profile data are noisy and precise results cannot be achieved anyways. Otherwise, a
value below 0.01 is preferred. Values below 0.001 have only marginal benefit while significantly
increasing the computation time.

The Estimation Scaling provides a way to control the data range searched by the Estimations. While the
first estimate begins as wide as possible, subsequent estimates begin around the latest best estimate,
and reduce the searched range by the scaling value. Reasonable values are between 1.0 (no reduction)
to 0.1 (severe reduction), with the default value of 0.5.

The scaling value should only be changed if the estimated model parameters are of poor quality. In such
a situation, the operator may attempt to widen the scaling value to a value closer to 1.0, while at the same
time significantly increasing both the Number of Estimations and the Maximum Iterations per Estimation .
Those settings force the search to be cast wider, at the expense of a substantial increase in computation
time.

If, on the other hand, a very slow computer is used to perform the estimates, and the data are known to
have very little noise, the operator may attempt to reduce the search scaling to 0.1, potentially reducing
the processing time while compromising the data quality.
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Configure Data Processing

When In Situ FIRe starts acquiring data in real time mode, it transmits raw data frames to FIReCom.
FIReCom has the ability to process these transmitted raw data frames and create and display processed
data frames. The following settings control which parts of the raw profiles are processed and what values
are produced.

Post Processing Options

The Post Processing Options allow you to specify which parts of the raw profiles to use to produce
processed values. Detailed descriptions of processed frames are specified in the Data Format Reference
section of this manual.

Advanced Post Processing Settings

The Advanced Post Processing Settings allow you to specify processing algorithm parameters and LED
calibration values.

On Board Processing

In Situ FIRe may also be outputting STF processed frames that can be produced in real time on board the
instrument. This feature is controlled via the Operation Mode option Process Single Turnover Flash
Data described in the FIRe Settings section.
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Processing Raw Data

Raw data files can be retrieved from In Situ FIRe as described in Transferring Files . Raw data files can
also be logged directly to a computer when acquiring data in real time as described in Logging Real Time
Data .

To process and/or replay (plot) raw files saved to the local computer, first ensure that In Situ FIRe is not
connected. Select Data -> Process Raw Data from the main menu to open the FIRe Raw File Processing
panel in the FIReCom dashboard.

Enter the following information in the FIRe Raw File Processing dashboard panel:

• Instrument Package File: Press the Browse button to select the instrument package XML file for
the In Situ FIRe that generated the raw data to be processed. This XML file can be found on the
CD-ROM provided with your In Situ FIRe. If you are managing data from more than one In Situ
FIRe, ensure that you select the Instrument Package File that corresponds with the raw data files
specified below.

• Raw Data Files: Press the Browse button to search for raw data files that have been transferred
from In Situ FIRe to the local computer. Files selected for processing are then listed in the area
below. If you are managing data from more than one In Situ FIRe, ensure that you select only raw
data files that correspond to the Instrument Package File specified above.

• Processed Data Files Directory : Press the Browse button to select the directory on the local
computer to which processed files should be saved.

Press the Processing Options button to show the Post-Processing Options dialog. Select one or more of
the Turnover Flash options in the Post-Processing Options dialog to enable creation of processed data
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files. If none of these is selected, normalized induction and relaxation profiles will be plotted in the
graphical display, but no processed data files will be generated.
Press the Process Data Files button to process the selected raw files. This button is alternately labeled
Playback Data Files when no STF/MTF options are selected in the Post-Processing Options dialog.
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Post-Processing Options
When acquiring real-time data from In Situ FIRe, or when processing retrieved or locally logged raw data
files, FIReCom processes and displays sensor data according to options specified in the Post-Processing
Options dialog.
There are two ways to show the Post-Processing Options dialog:

1. Select Data -> Post-Processing Options from the main menu.

2. Press the Processing Options on the FIRe Raw File Processing dashboard panel as described in
Processing Raw Data.

Note that all settings on this dialog apply only to processing performed by FIReCom software. These
settings have no effect on the processing performed on-board by In Situ FIRe.

• Use Blank Profile File(s): Select this option to apply one or more blank profile files when
processing raw data. Press the Browse button to identify a folder on the local computer that holds
the blank profile file(s) to be applied. When enabled determination of which Blank Profile(s) are used
for processing is based on the gain and the time-stamp of each profile that is processed. A more
detailed description of what a blank profile is and why a blank profile might be required is described
in the Deployment Procedures section.

• Single Turnover Flash Induction: Select this option to enable processing of the single turnover
flash induction phase.
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• Single Turnover Flash Relaxation: Select this option to enable processing of the single turnover
flash relaxation phase.

• Multiple Turnover Flash: Select this option to enable processing of the multiple turnover flash.
Note that only the relaxation phase of the multiple turnover flash is processed.

The following Processing Settings are for expert users only. Modification of these options can significantly
change the output of the processing routines and should not be changed without understanding their
effects.

Maximum Iterations per Estimation: This cutoff value controls the duration of data
processing, at the expense of data precision.
Alpha Electron Transport Rate: This parameter governs the maximum quantum yield for
whole chain electron transport at low light intensities, as a fraction of absorbed quanta
available for photosystem II (nominally 0.5).

In Situ FIRe - Data Recovery and Processing

103 / 132



Advanced Processing Settings

When acquiring real-time data from In Situ FIRe, or when processing retrieved or locally logged raw data
files, FIReCom processes and displays sensor data according to options specified in the Post-Processing
Options dialog. The default settings for averaging and parameter estimation are recommended for all
processing activity.

Expert users may, however, wish to experiment with alternate setting for averaging and parameter
estimation. To adjust advanced settings for offline processing ("post processing"), select Data ->
Advanced Post Processing Settings from the main menu to show the Advanced Processing Settings
dialog.

Note that all settings in the Advanced Processing Settings dialog apply only to processing performed by
FIReCom software. These settings do not apply to on-board processing performed by In Situ FIRe.

• STF Points Ignored : The initial three measurement points of the ST induction phase are normally
of low quality and not suitable for model parameter estimation. This setting determines how many of
the initial ST induction points should be discarded before processing. Do not change this setting
from the default (3) unless there is a confirmed deterioration of optical performance affecting one or
more subsequent induction points.

• MTF Points Averaged : This parameter controls how many of the last points of the MT induction
profile are averaged in order to estimate the maximum fluorescence. The default value of twenty
(20) is recommended for most situations. If data at the end of the induction are relatively noisy,
increasing this parameter may yield slightly better results, but increasing it too much can skew
results to the steeper start of the induction curve.

• Number of Estimations : This parameter determines how many independent estimations are
attempted. A small value reduces computation time at the expense of data accuracy. The value
should always be above 40. Values above 250 are of marginal benefit. Lower vales reduce
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computation time, especially on low-performance computer hardware, at the expense of data
accuracy.

• Estimation Scaling : This processing setting determines how far subsequent estimations search for
model parameters. A value of 1.0 searches for each subsequent estimation over the full region,
whereas a smaller value focuses on the interval centered around the current best result. Setting the
value below 0.1 is inadvisable, as the search may be too constrained, and the best result may be
missed.

• Estimation Tolerance : This processing setting defines when an estimation has converged. The
search within an estimation is terminated when subsequent search steps are advancing the quality
of the result by less than the specified tolerance.

• LED Maximum Excitation Intensity Induction Points : The number of trailing LED excitation
measurements from the induction to use in the calculation of the maximum LED light intensity.
Minimum 1, default 10, maximum 20.
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Replay Processed Data

FIReCom can graph or "replay" processed data files produced as described in Processing Raw Data . To
replay processed data;

1. Ensure that In Situ FIRe is not connected.

2. Select Data -> Replay Processed Data from the main menu to show the Replay Processed Data
dialog.

3. Press the first Browse button to select the Instrument Package File for the In Situ FIRe that
produced the processed file to be replayed.

4. Press the second Browse button to select the processed data file to be replayed. The corresponding
profile data file must be located in the same local folder.

5. Press OK to replay the processed data file and corresponding profile data file.

Processed data files that were produced by older versions of FIReCom software may not be compatible
with the replay feature. If the selected processed data file is incompatible, the original raw data must be
reprocessed to create a compatible processed data file.
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Troubleshooting
If FIReCom is unable to establish a connection to In Situ FIRe, check the physical connectors using a
multimeter with DC voltage measurement, resistance measurement, and continuity check capability.

WARNING! While checking voltages, extreme care should be used so as not to short the probe
leads. A shorted power supply or battery can output many amperes of current, potentially harming
people, starting fires, or damaging equipment.

Check Connections

The cable connections of the system should be checked for continuity and correctness. Make sure that all
Subconn ® connectors are free of dirt and lightly lubricated before mating. Do not use petroleum-based
lubricants. Satlantic recommends using a light coating of DC 111 silicone grease (made by Dow Corning
® ) on the male pins prior to connection. Also, ensure that the connections are complete and, if
applicable, the locking sleeves are secure.

• Check that the power cable is properly connected to the power supply and to In Situ FIRe.

• Check that the In Situ FIRe interconnect cable is in place and properly connected.

• Check that the RS 232 cable is connected to the correct communications port on the host computer
or data logger.

Check the Supply Voltage

To check voltages, a multimeter with DC voltage measurement is required.

Procedure:

1. Set the multimeter to measure a DC voltage.

2. If using a battery as the power source, measure the voltage directly at the battery terminals with the
multimeter. A new or fully charged 12 V battery usually measures in the 13 - 15 V range. If the
voltage is low (under 11 V), recharge or replace the battery. If using a DC power supply, set the
output voltage in the range from 10 - 18 V and then check the voltage with the multimeter.

3. Connect the power supply cable to the power source.

4. Being extremely careful not to short the probe leads , measure the voltage between the pins on
the supply cable. It should read approximately the same as the measurement taken in step 2. If the
voltages are not the same, recheck the power supply cable connections. If the voltages are still not
the same, the cable is likely broken and will need repair. A wire break can be confirmed with a
continuity check .
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5. If the voltage is within tolerance, connect the power supply cable to the FIRe.

6. Again, measure the voltage at the power supply terminals. The voltage should remain approximately
the same as before, although there may be a small voltage drop when using a battery (battery
voltage drops under load). If there is a significant voltage drop, disconnect the power immediately
and check for shorts in the cable.

Check Cable Continuity

Often, system problems can be traced to cable breaks or shorts. Usually, these cable failures are a result
of improper handling or storage. Cable continuity can be checked as outlined below. Make sure all
cables are completely disconnected before performing this test.

Procedure:

1. Set the multimeter to measure continuity. The resistance measurement setting can also be used.

2. Check for continuity by measuring from pin 1 on one end of the cable to pin 1 on the other end. The
meter should confirm that the connection is continuous by either giving an audible signal or
measuring a low resistance. If there is not continuity, there is a break in the cable, which will require
repair.

3. Repeat step 2 for all pins in the cable.

4. Check for shorts from pin 1 to all other pins by keeping one probe lead on pin 1 and touching the
other probe lead to each of the other pins in the same connector in turn. Repeat this for all pins on
the cable to make sure that all the pins are isolated from each other. The meter should read this as
open or measure a very high resistance. If any of the pins are not isolated, there is a short in the
cable, which will require repair.

Check Powerdown/Powerup

The FIRe has internal capacitors that protect the computer and file system when power is removed from
the system. After power down, it is necessary to wait about 20 seconds to allow the system to shut down
properly before applying power again. When the instrument is restarted, the boot up time is about 1
minute. After the 1 minute, if the FIRe is not connect via a USB cable, periodic flashing of the LEDs
should be visible.

Invalid Frames in Data

In any data logging application, there is a possibility that frames of data can be corrupted during
transmission. For each corrupt frame, a message indicating Lost Bytes is displayed in the Application tab
of the output panel. In addition to this, the FIReCom Error Event panel should be displayed. FIReCom will
display this frame corruption warning, hen ignore these corrupt data points and continue.
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No Connection to In Situ FIRe

If you are unsure if FIReCom is connecting to In Situ FIRe, try to manually connect using a terminal
emulation program such as HyperTerm. In Situ FIRe uses the following serial connection settings:

Data Bits 8
Parity None
Stop Bits 1
Flow ControlNone

The baud rate is set to 115200 in the default FIRe configuration. The baud rate may be changed for
custom applications. Finally, both a carriage return and linefeed are required for communication. See the
External Interfaces section for more details.

If a connection cannot be established, please Contact Satlantic for support.

FIReCom Event Logs

All activity that occurs with the FIReCom application is logged to disk in the event log. The event log is
rotated daily, the current log can be found at:

<INSTALL_DIR>\eventlogs\FIReCom.log

Although the contents of the log are somewhat cryptic and mainly for use by Satlantic personnel to
diagnose problems within the application, it will often provide clues to errors that exist within the
application. Each line in the log represents an event that occurs within the application. Below is a short
explanation of the format of the log file event:

Event Logs have the following format:

<Date/Time>, <Module>:<Event Code> ~ <Message>,<optional stack trace>

Date/Time - Displays the date and time when the message was logged.

Module - Displays the module that initiated the log message (either Internal, Core or GUI)

Event Code - internal code (i.e. ISC-1100-ERR) describing the module, internal error number and event
severity. Severity is either INF(info), WRN(warning) or ERR(error).

Message - A text based representation of the event

Stack Trace - Optionally occurs when unexpected errors happen to show the state of the application
when the error occurred.

When a problem occurs that cannot be easily explained, it may be necessary to send files to Satlantic to
determine the nature of the problem. When submitting an issue, please have the following information on
hand:

• The version of FIReCom you are using (select Help -> About on the main menu)
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• The version of firmware and serial number of the IN Situ FIRe you are using (see FIReCom
Dashboard)

• The raw data file that was logged on In Situ FIRe

• The FIReCom event log files

Change in Excitation Intensity

In Situ FIRe has eight excitation LEDs. The unlikely event of a failure in one of these LEDs can be
identified by a change in reference counts in the Sequence Plot. Any previous data from blanks or
samples could be used to obtain historical reference levels for the FIRe, provided they were low-turbidity
samples. If drops in excitation are observed, please Contact Satlantic.

Incorrect Time

If the In Situ FIRe internal clock loses its time setting every time it is restarted, then it is likely that the
clock battery is drained. Please Contact Satlantic to arrange a battery replacement.
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Maintenance
Preventative Maintenance

In Situ FIRe requires little maintenance. To prolong the life of the instrument:

• Protect In Situ FIRe from impacts

• Rinse In Situ FIRe in fresh water after each use

• Clean the optional flow cell with a pipe cleaner and mild detergent and de-ionized water rinse

• Always replace dummy connectors when In Situ FIRe is stored

• Carefully clean the optical windows (see below)

Cleaning the Optical Windows

In order to limit the possibility of damaging the optical windows, we suggest first rinsing the optics with
clean water to remove particulate matter and dissolve any salt residue. Then gently wipe the windows
clean with a cotton swab applicator and methanol or isopropanol, being careful to avoid leaving any
cotton fibers behind. De-ionized water may be used, however it may leave spots that can affect
transmission. Kimwipes or other lens tissue and methanol or isopropanol may also be used. In this case,
care must be taken to avoid getting finger grease on the windows. Wearing disposable gloves is
suggested to avoid grease transfer.

Do not soak the cotton swab or lens tissue with the cleaning agent. It will leave pools of liquid that will not
dry properly. Just dampen the applicator with the agent. The applicator should be moved over the window
in one direction and then discarded, or rotated to a different position so that contaminants are not rubbed
across the surface.

The optics should be rinsed with water before they are stored, or if they will not be used for a period of
time.
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Safety and Hazards
Personal Safety

WARNING!

If you suspect that In Situ FIRe has flooded, use EXTREME CAUTION around the instrument. In Situ
FIRe can operate at depths of up to 200 meters. If the instrument leaked at depth it might remain highly
pressurized when recovered and could cause the lamp housing or the spectrometer housing to be
launched from the coupler with extreme force if the restraining screws are removed.

An indication for flooding is that the instrument stops operating or that there is a short-circuit condition in
the instrument. The humidity readings increase when water enters the instrument. If you suspect a flood,
check the instrument for signs of pressurization. In a pressurized instrument, the gap between the
housings and coupler may be extended. Also an instrument flooded with salt water may short all of the
connector pins together. An electric continuity test between random pins on any of the bulkheads may
confirm this suspicion. Place the instrument in a safe location and contact Satlantic for further
instructions.

If the instrument cannot be safely stored for return, the following steps can be taken:

CONTINUE AT YOUR ON RISK!

The safest method to depressurize the FIRe sensor is to slowly back off the bulkhead connector. The
connector only has to be loosened so that the face seal o-ring is no longer sealed against the housing.
Pressurized water can then escape along the threaded portion of the bulkhead. When all of the pressure
has been released the instrument can be stored and safely shipped to Satlantic for repairs.

• The FIRe has an internal high-voltage supply. Do not operate with the housing removed!

• When operating on the bench top, the FIRe housing should be connected to earth ground to
minimize the risk of electric shock.

Instruments

• Do not leave instruments in direct sunlight. Direct sunlight can easily increase the internal
temperature of the instrument beyond its maximum rating.

Connections

• Handle electrical terminations carefully, as they are not designed to withstand strain. Disconnect the
cables from the components by pulling on the connector heads and not the cables. Do not twist the
connector while pulling, as this will damage the connector pins.
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• Do not use petroleum-based lubricants on Subconn® connectors. Connectors should be free of dirt
and lightly lubricated before mating. Satlantic recommends using DC-111 silicone grease (made by
Dow-Corning®) on the male pins prior to connection.

Troubleshooting

• While checking voltages with a multimeter, use extreme care to avoid shorting the probe leads. A
shorted power supply or battery can output many amperes of current, potentially harming the user,
starting fires, or damaging equipment.

Recovery

• Remember never to grab the electrical portion of the instrument cable during recovery. This can
cause damage to the bulkhead connector and the underwater splice.

• Be sure to rinse seawater from the instrument with fresh water prior to storage. Corrosion resulting
from failure to do so is not covered under warranty.
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Warranty
Warranty Period

All Satlantic equipment is covered under a one-year parts and labor warranty from date of purchase.

Restrictions

Warranty does not apply to products that are deemed by Satlantic to be damaged by misuse, abuse,
accident, or modifications by the customer. The warranty is considered void if any optical or mechanical
housing is opened. In addition, the warranty is void if the warranty seal is removed, broken or otherwise
damaged.

Provisions

During the one year from date of purchase warranty period, Satlantic will replace or repair, as deemed
necessary, components that are defective, except as noted above, without charge to the customer. This
warranty does not include shipping charges to and from Satlantic.

Returns

To return products to Satlantic, whether under warranty or not, contact the Satlantic Customer Support
Department and request a Returned Material Authorization (RMA) number and provide shipping details.
All claims under warranty must be made promptly after occurrence of circumstances giving rise thereto
and must be received by Satlantic within the applicable warranty period. Such claims should state clearly
the product serial number, date of purchase (and proof thereof) and a full description of the circumstances
giving rise to the claim. All replacement parts and/or products covered under the warranty period become
the property of Satlantic LP

Liability

IF SATLANTIC EQUIPMENT SHOULD BE DEFECTIVE OR FAIL TO BE IN GOOD WORKING ORDER
THE CUSTOMER'S SOLE REMEDY SHALL BE REPAIR OR REPLACEMENT AS STATED ABOVE. IN
NO EVENT WILL SATLANTIC LP BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF PROFITS,
LOSS OF SAVINGS OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING FROM THE
USE OR INABILITY TO USE THE EQUIPMENT OR COMPONENTS THEREOF.
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Contact Satlantic
If you have any questions, comments or concerns about your In Situ FIRe, please contact us.

Satlantic
3481 North Marginal Road
Halifax, Nova Scotia
B3K 5X8 Canada
PHONE: (902) 492-4780
FAX: (902) 492-4781
Email: Technical Support: support@satlantic.com
General Inquiries: info@satlantic.com
Web: http://www.satlantic.com

Business Hours

Satlantic is normally open for business between the hours of 9:00 AM and 5:00 PM Atlantic Time. Atlantic
Time is one hour ahead of the Eastern Time. Daylight saving time is in effect from 2:00 AM on the second
Sunday in March through 2:00 AM on the first Sunday in November. Atlantic Standard Time (AST) is
UTC-4. Atlantic Daylight Saving Time (ADT) is UTC-3.

Satlantic is not open for business during Canadian statutory holidays, which are as follows:

• New Year's Day January 1st

• Good Friday The Friday before Easter Sunday (Easter Sunday is the first Sunday after the full
moon on or following March 21 st , or one week later if the full moon falls on Sunday)

• Victoria Day The first Monday before May 25 th

• Canada Day July 1 st

• Civic Holiday The first Monday in August

• Labor Day The first Monday in September

• Thanksgiving Day The second Monday in October

• Remembrance Day November 11 th

• Christmas Day December 25 th

• Boxing Day December 26 th
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Data Format Reference
In Situ FIRe is capable of emitting and or logging several different telemetry data frame formats,
depending on the operation mode of the FIRe. These telemetry data frame formats are described in the
following sections.

Raw Data Format

The telemetry raw data frame format for the FIRe complies with the Satlantic Data Format Standard for
the Variable Binary Telemetry Frame. For every sample taken, the instrument will compose one frame of
raw data. If configured to do so, it will internally log the frame and transmit the frame via the serial
telemetry interface. The FIRe raw telemetry frame is described in detail in the table below. All fields
occurring in the frame are listed, and their meaning is explained. The fields' format and sizes are also
listed. The ASCI String (AS), the Binary Unsigned Integer (BU), and the Binary Floating Point (BD) data
types are used in the raw frame.

Table 1: FIRe Raw Data Frame Format

Field Name Format Description

Frame Header AS 10 The frame header or synchronization string starts with SAT for a
Satlantic instrument, followed by three characters identifying the
frame type. For the In-Situ FIRe this is FIR . The last four
characters are the instrument serial number. Examples are
SATFIR0001, SATFIR0301, SATFIR1005

Time BU 7 The date and time of the frame. This field follows Satlantic's
7-byte time stamp format.

Flash Type AS 1 Indicates the flash type used. Value 'S' for a Single Turnover
Flash and 'M' for a Multiple Turnover Flash.

Sequence Profile Total
Number

BU 2 The total number of profiles in the current flash sequence.

Sequence Ordinal
Number

BU 2 The ordinal position of the profile represented by this frame in the
current flash sequence.

Induction Phase number BU 2 Number of data points in the induction phase of the profile.

Relaxation Phase
number

BU 2 Number of data points in the relaxation phase of the profile.

Excitation Induction
Phase number

BU 2 Number of data points in the induction phase of the reference
excitation profile.

Excitation Relaxation
Phase number

BU 2 Number of data points in the relaxation phase of the reference
excitation profile.
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Gain Setting BU 1 The gain setting of the instrument when the profile was collected.
This indicates the relative gain with a range of 1-10.

Iteration Delay BU 2 The delay (ms) between the flash iterations during the collection
of one profile.

Number iterations BU 2 The number of flash iterations to use during the collection of one
profile.

Induction Phase durationBU 4 The length(µs) of the induction phase.

Relaxation Phase
duration

BU 2 The duration (µs) of the relaxation phase.

RPI BU 2 The initial interval (µs) between the relaxation phase pulses.

Induction Phase BU 2 Raw counts from the induction phase of the fluorescence profile

... ... ...

Relaxation Phase BU 2 Raw counts from the relaxation phase of the fluorescence profile

... ... ...

Reference Excitation
Induction Phase

BU 2 Raw counts from the induction phase of the fluorescence
reference excitation profile

... ... ...

Reference Excitation
Relaxation Phase

BU 2 Raw counts from the relaxation phase of the fluorescence
reference excitation profile

... ... ...

PAR BD 8 Measured PAR value read from analog-to-digital converter

Battery Voltage BU 2 Internal measurement of voltage read from analog-to-digital
converter

Pressure BU 4 Measured value from digital pressure sensor
Auxiliary Status Flag BU 2 A flag indicating auxiliary sensor status. The PAR sensor is

enabled if bit 0 is set and the pressure sensor is set if bit 1 is set.

Profile Error Flag BU 1 Error indicator for the collected profile data. A 0 value indicates
no error. A 1 indicates an error occurred during the collection of
the profile.

PAR Error Flag BU 1 Error indicator for the PAR data value. A 0 value indicates no
error. 1 indicates an error occurred when reading the value.
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Voltage Error Flag BU 1 Error indicator for the voltage data value. A 0 value indicates no
error. 1 indicates an error occurred when reading the value.

Pressure Error Flag BU 1 Error indicator for the pressure data value. A 0 value indicates no
error. 1 indicates an error occurred when reading the value.

LED Intensity Calibration
Coefficient

BF Calibration coefficient used during the calculation of the maximum
LED light intensity.

Frame Counter BU 1 Indicates the frame number. Resets after 255.

Check Sum BU 4 CRC32 checksum for the frame excluding the checksum and the
terminator.

Terminator BU 4 0xFF00FF00

Processed Data Format

If configured to do so, the FIRe will process the raw data, transmit a processed frame, and internally log
the processed frame. The telemetry processed data frame format follows the Satlantic Data Format
Standard for the Variable Length ASCII Telemetry Frame, with a ',' used as a field delimiter for every field.
The processed telemetry frame is described in detail in the table below.

Table 2: FIRe Processed STF Data Frame Format

Field Name Description

Frame Header The frame header or synchronization string starts with SAT for a
Satlantic instrument, followed by three characters identifying the
frame type. For the FIRe this is FIS indicating data processed from
a Single Turnover Flash. The last four characters are the
instrument serial number. Examples are: SATFIS0003,
SATFIS2222

Date Data collection date using the format YYYY-MM-DD

Time Data collection time using the format hh:mm:ss.sss

Pressure Pressure sensor value (pascals)

F o Calculated initial fluorescence (relative)

F m Calculated maximum fluorescence (relative)

F v Calculated variable fluorescence (F m -F o ) (relative)

F v /F m Calculated maximum quantum yield of photochemistry in PSII (F m
-F o )/F m
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p Connectivity factor (dimensionless). Defines the energy transfer
between PSII units.

Relative Relative functional absorption cross-section- sigma (relative)

Absolute Absolute functional absorption cross-section- sigma ( )

Maximum LED intensity Calculated maximum LED light intensity (units of PAR)

ETR Calculated Electron Transport Rate

1 Reoxidation distribution state 1 (not calculated on FIRe)

2 Reoxidation distribution state 2 (not calculated on FIRe)

3 Reoxidation distribution state 3 (not calculated on FIRe)

1 Reoxidation time constant 1 (not calculated on FIRe)

2 Reoxidation time constant 2 (not calculated on FIRe)

3 Reoxidation time constant 3 (not calculated on FIRe)

Normalized RMSe Normalized root mean square error

Gain Setting The gain setting of the instrument when the profile was collected.
This indicates the relative gain with a range of 1-10.

PAR Calibrated measured PAR value

Internal Voltage Calibrated measured voltage value (V)

Processing Results Error Flag Error indicator for the processed data. A 0 value indicates no error.
A 1 indicates that an error was flagged for the data in the raw data
or that an error occurred during processing.

PAR Error Flag Error indicator for the calibrated PAR value. A 0 value indicates no
error. A 1 indicates that an error was flagged for the raw PAR
value.

Voltage Error Flag Error indicator for the calibrated voltage value. A 0 value indicates
no error. A 1 indicates that an error was flagged for the raw voltage
value.

Pressure Error Flag Error indicator for the pressure value. A 0 value indicates no error.
A 1 indicates that an error was flagged for the pressure value in
the raw frame.

Check Sum CRC32 checksum for the frame excluding the checksum and the
terminator fields.
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Terminator CR/LF (Carriage return, Linefeed)

Post-Processed Data Format

The FIReCom program can be used to process FIRe raw data log files. The telemetry processed data
frame format follows the Satlantic Data Format Standard for the Variable Length ASCII Telemetry Frame,
with a ',' used as a field delimiter for every field. The processed telemetry frame is described in detail in
the table below.

Table 3: FIReCom Post Processed STF or MTF Data Frame Format

Field Name Description

Frame Header The frame header or synchronization string starts with SAT for a
Satlantic instrument, followed by three characters identifying the
frame type. For FIReCom this is either FPS indicating data
processed from a Single Turnover Flash or FPM indicating data
processed from a Multiple Turnover Flash. The last four characters
are the instrument serial number. Examples are SATFPS0003,
SATFPM2222

Date Data collection date using the format YYYY-MM-DD

Time Data collection time using the format hh:mm:ss.sss

Pressure Pressure sensor value (pascals)

F o Calculated initial fluorescence (relative)

F m Calculated maximum fluorescence (relative)

F v Calculated variable fluorescence (F m -F o ) (relative)

F v /F m Calculated maximum quantum yield of photochemistry in PSII (F m
-F o )/F m

p Connectivity factor (dimensionless). Defines the energy transfer
between PSII units.

Relative Relative functional absorption cross-section--sigma (relative)

Absolute Absolute functional absorption cross-section--sigma ( )

Maximum LED intensity Calculated maximum LED light intensity (units of PAR)

ETR Calculated Electron Transport Rate

1 Reoxidation distribution state 1
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2 Reoxidation distribution state 2

3 Reoxidation distribution state 3

1 Reoxidation time constant 1

2 Reoxidation time constant 2

3 Reoxidation time constant 3

Normalized RMSe Normalized root mean square error

Gain Setting The gain setting of the instrument when the profile was collected.
This indicates the relative gain with a range of 1-10.

PAR Calibrated measured PAR value

Internal Voltage Calibrated measured voltage value (V)

Processing Results Error Flag Error indicator for the processed data. A 0 value indicates no error.
A 1 indicates that an error was flagged for the data in the raw data
or that an error occurred during processing.

PAR Error Flag Error indicator for the calibrated PAR value. A 0 value indicates no
error. A 1 indicates that an error was flagged for the raw PAR value.

Voltage Error Flag Error indicator for the calibrated voltage value. A 0 value indicates
no error. A 1 indicates that an error was flagged for the raw voltage
value.

Pressure Error Flag Error indicator for the pressure value. A 0 value indicates no error. A
1 indicates that an error was flagged for the pressure value in the
raw frame.

Check Sum CRC32 checksum for the frame excluding the checksum and the
terminator fields.

Terminator CR/LF (Carriage return, Linefeed)

Post-Processed Profile Data Format

During post processing the FIReCom program also produces a more detailed output data product with
contains detailed intermediate processing products for each profile. The file is output in the same
directory and has the same name as the post processed data product with an appended "_profile" postfix
in the filename, It contains a data product for each frame. Each data product contains the following data.

• An list of ancillary data from the data original data frame used to produce the profile data product,
described in Table 4
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• A table of profile data, described in Table 5

Table 4: FIReCom Profile Header Data Format for Post Processed STF or MTF

Field Name Description

Frame Header The frame header or synchronization string starts with SAT for a
Satlantic instrument, followed by three characters identifying the
frame type,

SATFPH0001 (FPH="FIRe profile header")

Date Data collection date using the format YYYY-MM-DD

Time Data collection time using the format hh:mm:ss.sss

Pressure Pressure sensor value (pascals)

Maximum LED intensity Calculated maximum LED light intensity (units of PAR)

PAR Calibrated measured PAR value

Internal Voltage Calibrated measured voltage value (V)

Induction Phase number Number of data points in the induction phase of the profile.

Relaxation Phase number Number of data points in the relaxation phase of the profile.
Gain Setting The gain setting of the instrument when the profile was collected.

This indicates the relative gain with a range of 1-10.
Iteration Delay The delay (ms) between the flash iterations during the collection of

one profile.
Number iterations The number of flash iterations to use during the collection of one

profile.
Induction Phase duration The length(µs) of the induction phase.
Relaxation Phase duration The duration (µs) of the relaxation phase.
RPI The initial interval (µs) between the relaxation phase pulses.

Terminator CR/LF (Carriage return, Linefeed)

Table 5: FIReCom Profile Data Format for Post Processed STF or MTF

Field Name Description

Frame Header The frame header or synchronization string starts with SAT for a
Satlantic instrument, followed by three characters identifying the
frame type,

SATFPD0001 (FPD="FIRe profile data")

Time (offset) The time offset in (µs) from the start of the profile

Fluorescence counts Dark corrected counts from the fluorescence profile
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Reference counts Dark corrected counts from the reference profile

Fluorescence Yield The total fluorescence Yield for this time offset

Terminator CR/LF (Carriage return, Linefeed)

Data Log File Naming

In Situ FIRe is capable of internally logging its telemetry in local data files. The format for the names of
the FIRe telemetry files, specified as prefix_gain_timestamp_suffix.extension , is described in the table
below. Examples of file names are:

• SATFIR0001_01_2009-06-19_13-45-11_raw.bin

• SATFIR0001_01_2009-06-22_13-52-36_blk.bin

• SATFIS0001_01_2009-06-19_16-07-30_pro.csv

Table 5: Data Log File Naming Format

Section Description Example
prefix The frame header (see description in

the preceding tables) is the default file
name prefix.

• SATFIR001(raw frame)

• SATFIS001(processed frame)

gain Indicates the relative gain that was
used when the telemetry was
collected.

• 03

• 10

• AG (autogain)

timestamp Denotes the date and time of the
telemetry file creation. The format is
yyyy-MM-dd_HH-mm-ss .

• 2009-06-19_13-45-11

suffix Denotes the data product type.
• raw (raw telemetry)

• blk (blank profile)

• pro (processed telemetry)

extension Denotes the file data format.
• .bin (binary)

• .csv (comma separated ASCII values)
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Command Reference
In Situ FIRe can be configured and controlled via the serial command interface detailed below. Once a
$bk break command has been issured to put In Situ FIRe in commanded mode, it will resond to
commands for configuration, status, data operations, and primary control.

Configuration Commands

The $conf directive provides the following configuration commands to set operating parameters of In Situ
FIRe.

Command Parameter Description
$conf autogain on | off Turns the autogain function on or off.
$conf baudrate 1200 | 2400 | 4800 | 9600 |

19200 | 38400 | 57600 | 115200 |
230400

Sets the serial port baud rate.

$conf blank on | off Controls whether a blank subtraction is
used during processing of the STF
induction.

$conf calibpresssensor Floating point number
representing atmospheric
pressure in kPa.

Resets the calibration of the sensor
pressure.

$conf configuration None Displays the current configuration of
the FIRe instrument.

$conf datafileheader String ASCII comment inserted at the
beginning of all telemetry data files.

$conf datafileprefix String containing only the
following characters: 'A-Z', 'a-z',
'0-9', '-', '_', and '.'

String used as the prefix in the file
name of all telemetry data files.

$conf etralpha Floating point number with range
[0.0, 20.0]

Sets the # used in the electron
transport rate calculation.

$conf gain Integer with range [1, 10] Sets the relative gain of the FIRe
detection circuit. Used when the
automatic gain function is turned off.

$conf iterations Integer with range [1, 1000] Sets the number of repeated profiles
taken for a single profile. Used only
when in fixed iteration mode.

$conf itergain <gainLevel> Integer with range [1, 1000] Sets the number of iterations for the
specified gain level. Used only when in
variable iteration mode. gainLevel is
an integer with range [1, 10]

$conf itergainlow Integer with range [1, 1000] Sets the number of iterations for gain
levels 1 to 9. Used only when in
variable iteration mode.

$conf itergainmax Integer with range [1, 1000] Sets the number of iterations for gain
level 10. Used only when in variable
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iteration mode.
$conf itermode fixed | variable Sets the iteration mode to either fixed

or variable.
$conf ledintcalibcoef Floating point 0.0 or greater Sets the LED intensity calibration

coefficient used in the calculation of
the maximum LED excitation intensity

$conf ledintnoindpts Integer with range [1, 20] Sets the number of induction points
used in the calculation of the
maximum LED excitation intensity

$conf mtflen Integer with range [1000,
1000000]

Sets the duration in microseconds of
the Multiple Turnover Flash induction
phase.

$conf mtri Integer with range [5, 200] Sets the initial interval in microseconds
between the pulses of the Multiple
Turnover Flash relaxation phase.

$conf mtrp Integer with range [500, 50000] Sets the duration in microseconds of
the Multiple Turnover Flash relaxation
phase.

$conf para0 Floating point number Sets the PAR sensor calibration
coefficient a 0 .

$conf para1 Floating point number Sets the PAR sensor calibration
coefficient a 1 .

$conf parenabled on | off Controls whether the PAR sensor is
enabled or not.

$conf parim Floating point number Sets the PAR sensor calibration
immersion coefficient.

$conf pressureenabled on | off Controls whether the pressure sensor
is enabled or not.

$conf processstf on | off Controls whether the STF induction is
processed or not when collecting
profiles.

$conf profiledelay Integer with range [0, 1000] Sets the delay in milliseconds between
the individual iterations of a
fluorescence profile collection.

$conf serialport rs232 | rs422 Sets the serial communication channel
to be used by the FIRe instrument the
next time it is powered on.

$conf stflen Integer with range [1, 1000] Sets the duration in microseconds of
the Single Turnover Flash induction
phase.

$conf storeprocessed on | off Controls whether or not processed
data is stored on board the FIRe
instrument. Has no effect if processing
is not enabled.
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$conf storeraw on | off Controls whether or not raw data is
stored on board the FIRe instrument.

$conf stri Integer with range [5, 200] Sets the initial interval in microseconds
between the pulses of the Single
Turnover Flash relaxation phase.

$conf strp Integer with range [500, 50000] Sets the duration in microseconds of
the Single Turnover Flash relaxation
phase.

$conf synctime Integer greater than or equal to 0 Sets the FIRe instrument clock. The
input value represents the number of
seconds since 00:00:00 1 Jan 1970
UTC.

$conf transmitprocessed on | off Controls whether or not processed
data is transmitted from the FIRe
instrument during data acquisition.
Has no effect if processing is not
enabled.

$conf transmitraw on | off Controls whether or not raw data is
transmitted from the FIRe instrument
during data acquisition.

Get Commands

The $get command returns the current setting of the named parameter passed as the first argument.

Command Return Value Description
$get autogain on | off Retrieves whether the autogain

function is turned on or off.
$get baudrate 1200 | 2400 | 4800 | 9600 | 19200 |

38400 | 57600 | 115200 | 230400
Retrieves the serial port baud-rate.

$get blank on | off Retrieves whether or not blank
subtraction is used during STF
induction processing.

$get datafileheader String Retrieves the ASCII comment
inserted at the beginning of all
telemetry data files.

$get datafileprefix String containing only the following
characters: 'A-Z', 'a-z', '0-9', '-', '_',
and '.'

Retrieves the string used as the prefix
in the file name of all telemetry data
files.

$get diskspace Integer Integer Retrieves the unallocated space, in
bytes, and the total size, in bytes, of
the data directory partition

$get etralpha Floating point number with range
[0.0, 20.0]

Retrieves the # used in the electron
transport rate calculation.
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$get gain Integer with range [1, 10] Retrieves the relative gain of the FIRe
detection circuit used when the
automatic gain function is turned off.

$get iterations Integer with range [1, 1000] Retrieves the number of repeated
profiles taken for a single profile when
in fixed iteration mode.

$get itergain <gainLevel> Integer with range [1, 1000] Retrieves the number of iterations for
the specified gain level when in
variable iteration mode. gainLevel is
an integer with range [1, 10]

$get itermode fixed | variable Retrieves the iteration mode.
$get ledintcalibcoef Floating point greater than 0.0 Retrieves the LED intensity

calibration coefficient used in the
calculation of the maximum LED
excitation intensity

$get ledintnoindpts Integer with range [1, 20] Retrieves the number of induction
points used in the calculation of the
maximum LED excitation intensity

$get mtflen Integer with range [1000, 1000000] Retrieves the duration in
microseconds of the Multiple
Turnover Flash induction phase.

$get mtri Integer with range [5, 200] Retrieves the initial interval in
microseconds between the pulses of
the Multiple Turnover Flash relaxation
phase.

$get mtrp Integer with range [500, 50000] Retrieves the duration in
microseconds of the Multiple
Turnover Flash relaxation phase.

$get packagecrc 8 digit hexadecimal integer Retrieves the CRC-32 check sum of
the instrument package configuration
XML file.

$get para0 Floating point number Retrieves the PAR sensor calibration
coefficient a 0 .

$get para1 Floating point number Retrieves the PAR sensor calibration
coefficient a 1 .

$get parenabled on | off Retrieves whether the PAR sensor is
enabled or not.

$get paraim Floating point number Retrieves the PAR sensor calibration
immersion coefficient.

$get pressureenabled on | off Retrieves whether the pressure
sensor is enabled or not.

$get processstf on | off Retrieves whether or not the STF
induction is processed when
collecting profiles.
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$get profiledelay Integer with range [0, 1000] Retrieves the delay in milliseconds
between the individual iterations of a
fluorescence profile collection.

$get sequencecrc 8 digit hexadecimal integer Retrieves the CRC-32 check sum of
the profile sequence configuration
XML file.

$get serialnumber Integer between 1 and 9999 Retrieves the FIRe instrument serial
number.

$get serialport rs232 | rs485 Retrieves the serial communication
channel to be used by the FIRe
instrument the next time it is powered
on.

$get startupstatus [STATUS] where STATUS is either
GOOD or any combination of
MEDIACARD, INSTRCONFIG,
SEQUENCE

Retrieves the startup status of the
FIRe instrument. Indicates whether
the media card is missing, whether
the instrument config XML file is
missing, and whether the sequence
file is missing/corrupt.

$get stflen Integer with range [1, 1000] Retrieves the duration in
microseconds of the Single Turnover
Flash induction phase.

$get storeprocessed on | off Retrieves whether or not processed
data is stored on board the FIRe
instrument. Has no effect if
processing is not enabled.

$get storeraw on | off Retrieves whether or not raw data is
stored on board the FIRe instrument.

$get stri Integer with range [5, 200] Retrieves the initial interval in
microseconds between the pulses of
the Single Turnover Flash relaxation
phase.

$get strp Integer with range [500, 50000] Retrieves the duration in
microseconds of the Single Turnover
Flash relaxation phase.

$get time Integer greater than or equal to 0 Retrieves the FIRe instrument clock
time representing the number of
seconds since 00:00:00 1 Jan 1970
UTC.

$get transmitprocessed on | off Retrieves whether or not processed
data is transmitted from the FIRe
instrument during data acquisition.
Has no effect if processing is not
enabled.
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$get transmitraw on | off Retrieves whether or not raw data is
transmitted from the FIRe instrument
during data acquisition.

$get version String Retrieves the FIReOS software
version.

Data Commands

The $data directive provides commands for collecting, listing, downloading, uploading, and deleting data,
blanks, and metadata.

Command Parameter Description
$data blank none Requests the FIRe instrument to

collect a blank profile.
$data delete filename Requests the FIRe instrument to

delete the specified file from the
telemetry data directory.

$data deleteblank filename Requests the FIRe instrument to
delete the specified blank profile
file.

$data deletefiles none Requests the FIRe instrument to
delete all telemetry data files. Note
this does not delete any blank
profile files.

$data deletelog filename Requests the FIRe instrument to
delete the specified log file.

$data deleteprocessed filename Requests the FIRe instrument to
delete the specified processed
telemetry file.

$data deleteraw filename Requests the FIRe instrument to
delete the specified raw telemetry
file.

$data deletesequence none Requests the FIRe instrument to
delete the profile sequence
configuration file.

$data downloadblank filename Requests the FIRe instrument to
download the specified blank file.

$data downloadlog filename Requests the FIRe instrument to
download the specified log file.

$data downloadprocessed filename Requests the FIRe instrument to
download the specified processed
telemetry file.

$data downloadraw filename Requests the FIRe instrument to
download the specified raw
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telemetry file.
$data downloadsequence none Requests the FIRe instrument to

download the profile sequence
configuration file.

$data downloadxml none Requests the FIRe instrument to
download the instrument package
XML configuration file.

$data listblank none Retrieves a listing of the blank
profile files on the FIRe instrument.

$data listfiles none Retrieves a listing of all files in the
telemetry data directory on the
FIRe instrument.

$data listlog none Retrieves a listing of the log files on
the FIRe instrument.

$data listprocessed none Retrieves a listing of the processed
telemetry files on the FIRe
instrument.

$data listraw none Retrieves a listing of the raw
telemetry files on the FIRe
instrument.

$data profile none Requests the FIRe instrument to
collect a single fluorescence profile.

$data run none Requests the FIRe instrument to
start collecting data continuously.

$data transmit none Requests the FIRe instrument to
download all telemetry data files.
This includes all raw, processed,
and blank profile files.

$data uploadpatch filename crc32checksum Requests the FIRe instrument to
upload the specified patch file. If
the CRC32 checksum of the
uploaded file does not match the
specified one, an error response is
returned.

$data uploadsequence none Requests the FIRe instrument to
upload a profile sequence
configuration file.

$data uploadxml filename Requests the FIRe instrument to
upload an instrument package XML
configuration file with the specified
file name.
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Action Commands

The following action commands control the mode and operating state of In Situ FIRe.

Command Description
$bk Requests the FIRe instrument to go to commanded mode.
$qt Requests an exit of the FIReOS software running on the FIRe instrument.
$rb Requests a reboot of the operating system on the FIRe instrument.
$sd Requests a shut down of the operating system on the FIRe instrument.
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